INTRODUCTION

This document is for Consultant and State Employees responsible for the production or review of digital contract plans, specifications, supplemental contract documents, and contractor submittals. This document covers the development, review and commenting, and submission of digitally signed contract plans in PDF format including revisions, the delivery of specifications in Microsoft Word format, the delivery of supplemental contract documentation in PDF format, and the delivery of contractor submittals in PDF format. This manual also includes sections on the usability of these PDF documents.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.
Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.
Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988

Revision History

Digital Project Development Manual Revision History
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DEFINITIONS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SECTION 1</strong></td>
<td>DIGITAL DOCUMENT REQUIREMENTS</td>
<td>5-7</td>
</tr>
<tr>
<td>1.1</td>
<td>Final Document Deliverable</td>
<td>7</td>
</tr>
<tr>
<td>1.2</td>
<td>Requesting a Digital Project</td>
<td>Error! Bookmark not defined.</td>
</tr>
<tr>
<td>1.3</td>
<td>Prerequisites and Policies</td>
<td>7-11</td>
</tr>
<tr>
<td>1.4</td>
<td>Format</td>
<td>11-12</td>
</tr>
<tr>
<td>1.4.1</td>
<td>Contract Plans</td>
<td>12</td>
</tr>
<tr>
<td>1.4.2</td>
<td>Contract Specifications</td>
<td>11-12</td>
</tr>
<tr>
<td>1.4.3</td>
<td>Supplemental Documents</td>
<td>11-12</td>
</tr>
<tr>
<td>1.4.4</td>
<td>Contractor Submittals – Under Development</td>
<td>11-12</td>
</tr>
<tr>
<td>1.4.5</td>
<td>Engineering Reports</td>
<td>11</td>
</tr>
<tr>
<td>1.4.6</td>
<td>GIS Project Location Documents</td>
<td>11</td>
</tr>
<tr>
<td>1.4.7</td>
<td>ROW (Rights of Way) Documents</td>
<td>11</td>
</tr>
<tr>
<td>1.5</td>
<td>This Section Intentionally Left Blank</td>
<td>12</td>
</tr>
<tr>
<td>1.6</td>
<td>Contract Plan Drawing and Sheet Numbering</td>
<td>12-20</td>
</tr>
<tr>
<td>1.6.1</td>
<td>Drawing Number</td>
<td>20</td>
</tr>
<tr>
<td>1.6.2</td>
<td>Final Plan Page Labels and Sheet Numbers</td>
<td>20-21</td>
</tr>
<tr>
<td>1.6.3</td>
<td>Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers</td>
<td>21-22</td>
</tr>
<tr>
<td>1.7</td>
<td>CTDOT For Information Only Sheets</td>
<td>22-23</td>
</tr>
<tr>
<td>1.8</td>
<td>CTDOT Standard Sheets</td>
<td>23-24</td>
</tr>
<tr>
<td>1.9</td>
<td>Contract Plan Sheet Publishing</td>
<td>24-25</td>
</tr>
<tr>
<td>1.10</td>
<td>Example: Typ. Single Volume Digital Contract</td>
<td>25</td>
</tr>
<tr>
<td>1.11</td>
<td>Example: Multiple Volume Digital Contract</td>
<td>25-26</td>
</tr>
<tr>
<td>1.11.1</td>
<td>Combining Multiple Projects</td>
<td>26-27</td>
</tr>
<tr>
<td>1.12</td>
<td>Set Files</td>
<td>27-28</td>
</tr>
<tr>
<td>1.12.1</td>
<td>When a Set File is Created and Updated</td>
<td>28</td>
</tr>
<tr>
<td>1.12.2</td>
<td>Creating a Set File</td>
<td>28-29</td>
</tr>
<tr>
<td>1.12.3</td>
<td>Updating a Set File</td>
<td>29-30</td>
</tr>
<tr>
<td><strong>SECTION 2</strong></td>
<td>DIGITAL SIGNATURES FOR CONTRACT AND OTHER ENGINEERING DOCUMENTS</td>
<td>36-37</td>
</tr>
<tr>
<td>2.1</td>
<td>Graphic Image of Signature</td>
<td>37-38</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Contract Plans</td>
<td>38</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Engineering Reports</td>
<td>38-39</td>
</tr>
<tr>
<td>2.1.3</td>
<td>Working Drawings</td>
<td>39</td>
</tr>
<tr>
<td>2.2</td>
<td>Creating Graphic Image of Signature</td>
<td>39-40</td>
</tr>
<tr>
<td>2.2.1</td>
<td>In House CTDOT Signature</td>
<td>40</td>
</tr>
<tr>
<td>2.2.2</td>
<td>For Consultant Staff PE Stamp</td>
<td>40-41</td>
</tr>
<tr>
<td>2.3</td>
<td>Setting Digital Signature Appearance Preferences</td>
<td>41-42</td>
</tr>
<tr>
<td>2.4</td>
<td>Watermarking Plans with Graphic Image of Signature</td>
<td>42</td>
</tr>
<tr>
<td>2.5</td>
<td>Digital Signature Fields</td>
<td>42-43</td>
</tr>
<tr>
<td>2.5.1</td>
<td>Bluebeam - Creating Digital Signature Form Fields</td>
<td>43-44</td>
</tr>
<tr>
<td>2.6</td>
<td>Applying Digital Signatures</td>
<td>44-45</td>
</tr>
<tr>
<td>2.6.1</td>
<td>Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)</td>
<td>45</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Applying a Digital Signatures to 02_Revisions Subset</td>
<td>45-46</td>
</tr>
<tr>
<td>2.6.3</td>
<td>All Other Discipline Subsets - Single Signature</td>
<td>46</td>
</tr>
<tr>
<td>2.6.4</td>
<td>Standard Drawing Subsets – Single Signature</td>
<td>46-47</td>
</tr>
<tr>
<td>2.6.5</td>
<td>All Other Discipline Subsets – Multi-Signatures</td>
<td>47</td>
</tr>
<tr>
<td>2.6.6</td>
<td>Working Drawings</td>
<td>47-48</td>
</tr>
<tr>
<td>2.6.7</td>
<td>Engineering Reports</td>
<td>48-49</td>
</tr>
<tr>
<td>2.7</td>
<td>Applying Digital Signature Workflows</td>
<td>49-50</td>
</tr>
<tr>
<td><strong>SECTION 3</strong></td>
<td>SUBMITTING DOCUMENTS TO CTDOT PROJECTWISE</td>
<td>57-58</td>
</tr>
<tr>
<td>3.1</td>
<td>Discipline Subset Submittal Checklist</td>
<td>58-59</td>
</tr>
<tr>
<td>3.2</td>
<td>Projectwise</td>
<td>59-60</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Projectwise</td>
<td>60-61</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Projectwise Folders for Contract Documents</td>
<td>61</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Uploading Documents - Projectwise (Thin Client)</td>
<td>61-62</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Uploading Documents – Projectwise (Thick Client)</td>
<td>62-63</td>
</tr>
<tr>
<td>3.2.5</td>
<td>Combining and Uploading Contract Specifications and CSI Special Provisions</td>
<td>63</td>
</tr>
<tr>
<td>3.2.6</td>
<td>Uploading Supplemental Contract Documents</td>
<td>63-64</td>
</tr>
<tr>
<td>3.2.7</td>
<td>CTDOT Contracts Finalizing of Contract Specifications</td>
<td>64-65</td>
</tr>
<tr>
<td>3.2.8</td>
<td>Notification of Submittals</td>
<td>65-66</td>
</tr>
<tr>
<td>3.2.9</td>
<td>Contract Plans Workflow (FDP + Advertise)</td>
<td>66-67</td>
</tr>
<tr>
<td>3.2.10</td>
<td>Projectwise Project folder Security</td>
<td>67-68</td>
</tr>
<tr>
<td>3.2.11</td>
<td>100_Contract_Plans (PDF) Folder (Dynamic Security)</td>
<td>68-69</td>
</tr>
<tr>
<td>3.2.12</td>
<td>Changing the State of a Document</td>
<td>69-70</td>
</tr>
<tr>
<td>3.2.13</td>
<td>Paper Plan Order Form</td>
<td>70-71</td>
</tr>
<tr>
<td><strong>SECTION 4</strong></td>
<td>CONTRACT PLAN AND SPECIFICATION REVISIONS (ADDENDA AND DESIGN INITIATED CHANGE ORDER)</td>
<td>74</td>
</tr>
</tbody>
</table>

Issued 01-2015  Version 3.08
CHAPTER 1: PROJECT DEVELOPMENT WORKFLOWS

1.1 Addenda............................................................................................................74
  1.1.1 Revised Plans - Addenda........................................................................75
  1.1.2 New Sheets - Addenda ........................................................................75
  1.1.3 Adding New Subset – Addenda..............................................................76
  1.1.4 Voided Sheets .......................................................................................77
  1.1.5 Addenda Plans Workflow ......................................................................77
  1.1.6 Addenda Specifications ........................................................................78
  1.1.7 Addenda Report ...................................................................................78
  1.1.8 Addendum CTDOT Standard Drawing Subsets ....................................78

1.2 Design Initiated Change Order (DCO)...........................................................78
  1.2.1 Revised Sheets – DCO .........................................................................79
  1.2.2 New Sheets – DCO ............................................................................80
  1.2.3 New Subset – DCO .............................................................................81
  1.2.4 Voided Sheets .....................................................................................81
  1.2.5 DCO Specifications ............................................................................81
  1.2.6 DCO CTDOT Standard Sheet Subsets ................................................82

1.3 02-Revisions Subset........................................................................................82
  1.3.1 02_Revisions Subset Workflow - Addenda ...........................................84
  1.3.2 02_Revisions Subset Workflow - DCO ...............................................85
  1.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset ...............85
  1.3.4 Filling Out Revision Index Sheet ..........................................................85

1.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets ...............86

SECTION 5: AS-BUILT COMMENTS - FINAL PLANS..............................................89

5.1 As-Built Revisions (Digital Comments) Workflow..........................................89
  5.1.1 Post Construction As-Built ...................................................................90
  5.1.2 Active As-Built ..................................................................................90

5.2 AS-Built Markup of Contract Plans................................................................90

5.3 Applying As-Built Comments to Contract Plans ..........................................91
  5.3.1 Before Using Bluebeam for As-Built ...................................................91
  5.3.2 Opening the Contract Plans from Projectwise .......................................91
  5.3.3 Applying Digital As-Built Stamps .......................................................93
  5.3.4 Applying Digital As-Built Notes ..........................................................97

5.4 Notifications................................................................................................100
  5.4.1 Completion of the As-Buils..................................................................100
  5.4.2 Notifying Department Personnel .......................................................100

SECTION 6: CONTRACTOR SUBMITTALS ............................................................101

6.1 Workflows ..................................................................................................102

6.2 Submittal Format Requirements ................................................................104

6.3 Contractor – Adding Documents to the Contractor Submittals ....................107
  6.3.1 Initial Submittal ..................................................................................107
  6.3.2 Contractor – Subsequent Submittals (Revise and Resubmit) ...............114

6.4 CTDOT/Consultant – Contractor Submittal Review......................................119
  6.4.1 Initial Contractor Submittal Review ......................................................120
  6.4.2 Subsequent Contractor Submittal Reviews .........................................131

SECTION 7: DIGITAL REVIEW AND COMMENTING............................................136

7.1 Introduction..................................................................................................136

7.2 Prerequisites ................................................................................................137

7.3 Digital Review Workflow ............................................................................138

7.4 Phase 1 – Digital Document Preparation ...................................................139
  7.4.1 Organization .......................................................................................139
  7.4.2 Preparation and Format .................................................................139
  7.4.3 Uploading .........................................................................................140

7.5 Phase 2 – Set Up Digital Review ................................................................145

7.6 Phase 3 – Invitation to Review Session ......................................................151

7.7 Phase 4 – Digital Review ............................................................................152
  7.7.1 Joining a Review Session .................................................................152
  7.7.2 Review Session Layout .................................................................156
  7.7.3 Reviewing .......................................................................................157

7.8 Phase 5 – Closing the Digital Review ........................................................167

7.9 Phase 6 – Resolve Comments ....................................................................169
  7.9.1 Notify Authors ..................................................................................169
  7.9.2 Resolving Comments .................................................................169

7.10 Locking the Review Documents after the Review .......................................175

SECTION 8: CTDOT PROJECT LOCATION – UNDER DEVELOPMENT..............176

8.1 Project Location - RPM.................................................................................179
  8.1.1 Route and Mileage .............................................................................179
  8.1.2 List of Assets for the Project ..............................................................180
  8.1.3 Project Polygon Creation and Submission .........................................181

8.2 Project Location - Design Approval through Construction .........................189
  8.2.1 Project Polygon .................................................................................189
DEFINITIONS

ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline subset.

ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline subset.

ADP – The attribute applied to an Addendum discipline subset.

Bluebeam – PDF software similar to Adobe Acrobat. Bluebeam software will be required to package and markup all Shop Drawing Submittals.

DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline subset.

DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline subset.

Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF document.

DCO – The attribute applied to a design initiated change order discipline subset.


Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets. For CTDOT staff this would be the Principal Engineer.
FDP – The attribute applied to a final design plans discipline subset.

FIO – The attribute applied to a “for information only” discipline subset.

FPL – The attribute applied to an advertised FDP discipline subset

Project Manager – Lead designer on the project. For CTDOT staff this would be the TE 3 or Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

Projectwise - CTDOT is currently using Bentley’s ProjectWise as a data management software for digital projects. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available. Projectwise shall be used by all consultant engineers delivering digital contract documents.

Set File – Is a consolidated viewer file that is created using Bluebeam. When this file is opened all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the correct order.

STD – The attribute applied to the “CTDOT Standard Drawings” discipline subsets.

WDP – The attribute applied to working drawing for permanent structures submittals. This includes the plans, calculations, or any supplemental documents in the submittal.
Section 1  Digital Document Requirements

1.1 Document Deliverable

The following documents shall be submitted into Projectwise when delivering a digital project, see Section 3 of this document for submittal procedures for the documents below: For CTDOT designed projects each discipline is responsible for uploading their own documents into Projectwise.

- Preliminary and Final Contract Plans
- Preliminary and Final Contract Specifications
- Supplemental Contract Documents - Include but not limited to the following:
  - Proposal Estimate, with signed checklist
  - Federal Estimate
  - Calendar Day Estimate
  - Final Design Report
  - Categorical Exclusion
  - Design Approval Letter
  - Environmental Permits
  - DBE/SBE Approval with percentage
  - Commitment list
  - Agreements
  - Proprietary Item Approval
  - Standalone Transportation Management Plan Document, taken from the final design report

- Engineering Reports
  - Hydraulic Report
  - Hydraulic Report Data
  - Scour Report
  - Scour Report Data
  - Floodway Report
  - Floodway Report Data

- GIS Project Location Documents
  - Project Polygon Files (.dgn and KML)

- ROW Documents
  - Property Map (.dgn)
  - Property Map (pdf)
  - ROW Parcel Files (.dgn and KML)

- Working Drawings for Permanent Structures
- Working Drawings for Temporary Structures
- Shop Drawings

1.2 Projectwise Project Container

CTDOT uses Bentley’s Projectwise as a document management system for all of our capital projects. A project container will be created in Projectwise when a project is initiated. CTDOT employees will have access to all projects, but access for consultants, municipalities or other agencies must be requested by the Consultant Liaison Engineer. The Consultant Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov and DOT.AECApplications@ct.gov

1.3 Prerequisites and Policies

1. All contract plans, working drawings, and engineering reports submitted to the Department shall be digitally signed by a CT licensed Engineer or CT licensed Architect in accordance with this manual. All contract plans, specifications, and supplemental
contracts documents will only be accepted by the CTDOT if they meet all the requirements of this manual. Approval for additional development and testing of digital documents and procedures shall come from the AEC Applications.

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be digitally signed in conformance with this manual.
   a. Digital signatures must meet the requirements of Adobe’s Certified Document Services (CDS).
   b. CDS, and CDS vendor information is provided at the following website: http://www.adobe.com/security/partners_cds.html
   c. Trial CDS Signatures will not be accepted by the Department, a signature must be purchased from one of the CDS Vendors.
   d. Bluebeam Revu or Extreme is required for all digital signature processes.

3. After contract plans have been advertised, the digital signature is not allowed to be removed.


5. Use of digital signatures not conforming to the requirements of this manual must be approved by both the Office of Quality Assurance, and the Office of Legal Services.

6. This manual is designed to be used with the latest CTDOT Digital Design Environment.

7. Digital Contract Specifications shall be prepared in accordance with the Departments policies and procedures for Contract Development.

8. Supplemental contracts documents shall be submitted digitally in PDF format. See Section 3.2.8 for supplemental contract document list and submission procedures.

9. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using the [Digital Submission Procedure set forth in this Manual] has the same force and effect for the purposes of the Consulting Engineer’s agreement with the State as a signature and seal of a Connecticut Licensed Professional Engineer or Architect as set forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the Connecticut General Statutes, as applicable. Nothing in this DPD serves as an authorization for, or endorsement of, the use of this [Digital Submission Procedure] generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional Engineer or Architect with respect to other work it performs for the State or work it performs for other clients.

10. Bluebeam Revu was used in the production of all figures and procedures in this manual. A license of Bluebeam Revu must be purchased to perform all the procedures in this manual.

11. Bluebeam shall be the only PDF software supported by the Connecticut Department of Transportation for the processes set forth in this manual. Import the Bluebeam profile as shown in Appendix A. This will place all the tools and tool bars in the correct location.

12. When on call consultants are used for CTDOT projects, the title sheet shall be digitally signed by CTDOT following the procedure in Section 2.6.1 of this manual.

13. All documents detailed in the processes in the following manual are uploaded to CTDOT’s Projectwise site. To gain access to CTDOT’s Projectwise site fill out the following form: CTDOT Projectwise New User Form

1.4 Format

1.4.1 Contract Plans

1. Digital contract plans (preliminary, semifinal, FDP, etc.), working drawing plans and shop drawing plans shall be in PDF format; PDF Plans must be sized either 36” x 24” for projects created before 6/2007 or sized 34” x 22” for projects created after 6/2007; PDF plans shall be measurable to scale in the PDF; PDF plans shall be able to be printed to paper and scaled appropriately; text must be searchable; and all levels must have the
Connecticut Department of Transportation Digital Project Development Manual

ability to be displayed on or off, unless approved otherwise. All information on the digital contract PDF plans shall have been created from MicroStation or an approved alternate. The only information that shall be added to the plans using a PDF editing software are as follows:

a. Page labels (see Section 1.6.2)
b. Sheet numbers (see Section 1.6.2)
c. Watermarks and flatten comments (see Section 2.4)
d. Any digital signature fields (see Section 2.5)
e. Digital Signature (see Section 2.6)
f. Attach the PW Submittal Checklist (see Section 3.1)

2. Contract plans shall be grouped, by discipline into individual multiple page PDF files called discipline subsets. Discipline subsets are not to be combined in a PDF Package/Portfolio. Examples of discipline subsets are: 01_General, 02_Revisions, 03_Highway, 04_Bridge, etc. See Section 1.11 & 1.12 for more examples of discipline subsets.

Using a discipline subset format streamlines both the development of contract plans and the administration of the plans during preliminary design, FDP, DCD, Addenda, DCO and As-Built submissions. Moreover, it also leverages the ability to digitally sign the individual discipline based contract plan subsets per designer.

![Figure 1 Discipline Subset Bookmarks, Index of Drawings, & Signature fields](image)

3. See Section 2.5 for digital signature form field place holder cells.

4. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The subset numbers shall be selected by the lead designer so that the FIO subsets are last. Each sheet shall be numbered correctly, see Section 1.6.2. Upload and attribute in accordance with Section 3.2.

5. Utility drawings shall be submitted in accordance with the following:
   a. Utility plans For Information Only (FIO) shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature, but each sheet shall be labeled; “For Information Only”. FIO utility subsets shall be numbered so that they are the last subsets. Example Labels; 10_CL&P_FIO, 11_AT&T_FIO
   b. Utility company designed plans that include work being done by the States Contractor shall be submitted in a utility subset based on the utility company,
Connecticut Department of Transportation Digital Project Development Manual

AT&T subset, CL&P subset, etc. These subsets do not require a digital signature. Example Labels: 10_CL&P, 11_AT&T

c. Utility plans that are designed by Utility or State Consultant firms that include work being done by the States Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in accordance with this manual. Example Labels: 10_CL&P, 11_AT&T

6. See Section 3.2 for uploading and attributing Utility Plans. See Section 1.11 & 1.12 for more examples of discipline subsets.

7. CTDOT Standard sheets shall also be delivered digitally. See section 1.8 for how to prepare and submit CTDOT Standard Sheets.

8. The first and second subsets in the project must always be the 01_General and 02_Revisions respectively. The Project Manager is responsible for determining the order of all other discipline subsets, Sections 1.11 and 1.12 show examples.

9. Discipline subsets shall contain a maximum of 150 sheets.

10. Discipline subsets shall be published directly from a CAD application. Scanned images or raster image formats will not be accepted with the exception of For Information Only sheets, these can be scanned.

11. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. See Section 1.6.2, “Sheet Numbering”

12. Each subset shall contain bookmarks; one for each page. Figure 1 displays an example of bookmarks. See Publishing_MicroStation_Content_to_PDF_Format.pdf for more instructions.

   a. Figure 1 also displays examples of subgroup folders. While publishing, subgroups may be created to contain similar sheets. See Publishing_MicroStation_Content_to_PDF_Format.pdf for more instructions.

13. Levels with the appropriate CTDOT names shall have the ability to be displayed on or off within the PDF document.

14. The first page of the subset 01_General shall be the CTDOT digital project title sheet which includes an index of the subsets contained within the project, sheet count totals for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for applying the digital signature(s) (see section Section 2.5).

   Link to digital title sheet: Digital Title Sheet

Consultants will need to delete the CTDOT signature blocks on the title sheet and place a digital signature placeholder as detailed in section Section 2.5

CTDOT engineers can find the digital title sheet in the seed files on our W: drive.

15. The 01-General subset shall include all detailed estimate sheets.

16. The 02_Revisions subset must be included in each digital project and there shall only be (1) revisions subset.

17. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See Section 4.3. These revision sheets are used for tracking all sheet changes due to addenda and design initiated change order (DCO) with respect to the entire project. These sheets are originally blank and unsigned, and shall be managed and updated as needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained here:

   CTDOT Designed Projects - 02 Revisions Subset
   Consultant Designed Projects - 02_Revisions_CE_Subset

18. The first page of each subset shall be a subset cover sheet, this includes FIO subsets. This cover sheet shall contain both; an index of drawings contained within the subset that includes both drawing numbers and drawing titles and the form field place holder(s) which receives the digital signatures. The following cell has a table for the index of drawings and the digital signature cell place holder BDR_Discipline_Cover Sheet cell. This table must include the subset name and number displayed as a heading in the table. See Figure 1 for an example.
19. As-built information shall be digitally applied to the contract subsets by District Personnel after the job is complete using Bluebeam. See section 4.5.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, but do not need to be digitally signed.

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change orders in accordance with section 1.12.

1.4.2 Contract Specifications

22. Digital Contract Specifications shall be submitted in MS Word format and in accordance with the Departments policies and procedures for Contract Development. CSI special provisions shall be submitted in pdf format.
   a. For projects where a consultant is the Project Manager on the project, the Specification and CSI special provisions submittals shall be submitted in (1) zipped folder, see section 3.2.6.
   b. For projects where a CTDOT design unit is the Project Manager on the project, the Specification and CSI special provisions shall be submitted in individual zipped folders per discipline, see section 3.2.6.
   c. Design Initiated Change Orders shall be placed in (1) pdf document, with “C#” and the date in the header. An example would be “Rev. C1 - mm/dd/yy”.

1.4.3 Supplemental Documents

23. Supplemental documents shall be 8.5” x 11” pdf documents, except the proposal estimate which shall be in “.est” format. Documents that require signatures may be scanned with a minimum resolution of 200 dpi, and size = 8.5”x11”. These documents do not need to be digitally signed.

1.4.4 Contractor Submittals

24. See Section 6 for format, submittal and review requirements for Contractor Submittals: Working Drawings and Shop Drawings.

1.4.5 Engineering Reports

25. The Hydraulic, Scour, and Floodway reports shall be formatted in accordance with the following:
   a. Shall be native PDF whenever possible.
   b. Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
   c. All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
   d. Shall be digitally signed and watermarked in accordance with Section 2 of this manual.
   e. Any data files that must accompany the PDF report shall be uploaded into Projectwise in a zipped folder.
   f. The Engineering Reports and zipped folder for any data files shall be submitted into the 130_Engineering Reports folder in accordance with Section 3 of this manual.

1.4.6 GIS Project Location Documents

26. Project location for all projects shall be submitted to CTDOT. See Section 8 for the format and submission requirements.

1.4.7 ROW (Rights of Way) Documents

27. Property Maps and Parcel Polygon files for acquired property shall be submitted to CTDOT. See Section 9 for the format and submission requirements.
1.5 This Section Intentionally Left Blank

1.6 Contract Plan Drawing and Sheet Numbering

1.6.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall consist of the discipline designator followed by a hyphen and the sheet number. The discipline designator shall remain constant across each discipline subset. For example; a highway subsets discipline designator shall be “HWY”, therefore any sheets in the highway discipline subset would contain the following drawing numbers; HWY-01, HWY-02, etc.

Discipline subsets can be as broad or specific as the Project Manager would like. An example would be the highway sheets can be split out into multiple subsets. They can place all the profiles in one discipline subset where the drawing number would be PRO - ## and they can place all cross sections in another discipline subset, where the drawing numbers would be XSC - ##.

The CTDOT efficiently maintains the drawing numbers in MicroStation using the model properties and project explorer, See the following workflow Project Explorer to Manage Drawing Numbers

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

![Contract Drawing Numbering](image)

1.6.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the number pages and header and footer tools within Bluebeam. Page labels and sheet numbers shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic subset shall be 05.01.
The page label and sheet number place holder shall be determined by the total estimated sheet count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly assemble the contract plans into a properly ordered consolidated set that District Construction takes advantage of during construction of the project.

**Single Volume Projects:**

The page labels and sheet numbers, for single volume projects shall be a concatenation of the discipline subset number, a decimal point, and the sheet number. For example; the page labels and sheet numbers for subset “4” would be as follows: less than 100 sheets 04.01, 04.02, 04.03, etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline their corresponding subset number, see section 1.11.

**Multi Volume Projects:**

For a multi volume project the page labels and sheet numbers shall be a concatenation of the volume number, a decimal point, the discipline subset number, a decimal point, and finally the sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.01.

Volume numbers shall be used on large projects. They are effective because the Project Manager only has to deliver to the other engineers their perspective volume numbers, allowing them to manage their subset numbers independently of the other discipline volumes and subset counts, see section 1.12.

Subset numbers shall start at 01 for all volumes.
BLUEBEAM - Applying Page Labels and Sheet Numbers
To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

   (1) Select thumbnail icon
   (2) Right Click on a thumbnail
   (3) Select Number Pages

   Figure 4 - Adding Page Labels

   For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once. In the case where there are 10 or more sheets in the subset the following will have to be done twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be “04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

   (1) Select this style
   (2) Insert correct prefix
   (3) Start at 1 for sheets 1-9 and 10 for sheets 10-99
   (4) Apply to correct pages
   (5) Click OK

   Figure 5 - Page Labeling
3. Now the pages will be labeled:

![Page labeling screenshot](image)

**Figure 6 - Labeled Pages**

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and then “Header & Footer”

![Header footer tool screenshot](image)

**Figure 7 - Header Footer Tool**
5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted as necessary. After you select the font, set the margins, and type in "<<PageLabel>>" as shown below. Then click save for save settings. The next time you are going to apply sheet numbers to a subset, you can simply select the saved settings. Then click OK.

Figure 8 - Insert Sheet Numbers
1.6.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A#” at the end and Change Orders need to have “.C#” at the end (see section 4 for addendum and change order sheet numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to each sheet in the addendum or change order. This can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

   ![Figure 9 - Adding Page Labels](image)

(1) Select thumbnail icon
(2) Right Click on a thumbnail
(3) Select Number Pages
3. Select None for a style, type in the sheet number of the addendum or change order sheet in the prefix line. Then select which sheet you are labeling. This has to be done for each sheet in the addendum or change order separately. See below:

Figure 10 - Applying Addendum Page Labels

4. After all page labels have been applied, the sheet numbers can be applied. From Bluebeam select the Document tab and then “Header & Footer”

Figure 11 - Header Footer Tool
5. Select your sheet numbers saved settings from before and click OK. Note the margins and size may have to be adjusted as necessary.

(1) Select your save settings

(2) Click OK

Figure 12 - Applying Addendum or DCO Sheet Numbers

1.7 CTDOT For Information Only Sheets

Plans provided *For Information Only* (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These sheets shall be placed on a border and numbered in accordance with section 1.6.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last. See Section 3.2 for uploading and attributing FIO Plans. See Section 1.11 & 1.12 for more examples of discipline subsets. Information only sheets may be scanned, but must conform to the following specifications; Minimum Size 22”x34”, Minimum dpi = 300.

This link shows a procedure that can be used to create a For Information Only subset using Bluebeam: Preparing a For Information Only Subset
1.8 CTDOT Standard Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital project.

1. Download the latest standards from the following link for the project: CTDOT Standard Drawings Website
2. Upload the standard subset into Projectwise in accordance with section 3.2.
3. Next open up the standards from Projectwise by double clicking on it. Once it opens click on the index sheet.

![Figure 13 - Preparing the Standard Subsets](image)

4. Then enter the project number and check the standards to be included in the project.

![Figure 14 - Enter Project Number and Check Boxes](image)
5. Delete the standards that are not included in the project as shown below:

1. Click on the standards file

2. Right Click and select delete on drawings not included in project

![Figure 15 - Deleting Drawings from Standard Set](image)

6. Next digitally sign all index sheets in accordance with section 2.6

1.9 Contract Plan Sheet Publishing

CTDOT currently uses MicroStation V8i Print Organizer to publish contract plans to a PDF format.

The workflow [Publishing_MicroStation_Content_to_PDF_Format.pdf](#) shows the fundamentals of publishing contract plans to PDF from MicroStation.
1.10 Example: Typ. Single Volume Digital Contract

Single volume digital contracts are used when each discipline or consulting firm designing the project is responsible for 3 subsets or less. The following is an example of a single volume project. Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-Structure, etc. The FIO subsets shall be placed at the end of a project right before the STD subsets.

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-General</td>
<td>Title Sheet</td>
</tr>
<tr>
<td></td>
<td>Detail Estimate Sheet</td>
</tr>
<tr>
<td></td>
<td>Etc</td>
</tr>
<tr>
<td>02-Revisions</td>
<td>Index of Revisions Sheets</td>
</tr>
<tr>
<td>03-Highways**</td>
<td>Index of Plans</td>
</tr>
<tr>
<td></td>
<td>Survey Data</td>
</tr>
<tr>
<td></td>
<td>Alignments</td>
</tr>
<tr>
<td></td>
<td>ROW</td>
</tr>
<tr>
<td></td>
<td>Typ Sections</td>
</tr>
<tr>
<td></td>
<td>Misc Details</td>
</tr>
<tr>
<td></td>
<td>Intersect Grading</td>
</tr>
<tr>
<td></td>
<td>Boring Logs</td>
</tr>
<tr>
<td></td>
<td>Highway Plans</td>
</tr>
<tr>
<td></td>
<td>Breakout Drainage</td>
</tr>
<tr>
<td></td>
<td>Highway Profile</td>
</tr>
<tr>
<td></td>
<td>Highway X-Sections</td>
</tr>
<tr>
<td></td>
<td>Sections</td>
</tr>
<tr>
<td></td>
<td>Landscape Plan</td>
</tr>
<tr>
<td></td>
<td>Wetland Mitigation</td>
</tr>
<tr>
<td>04-Structure</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Structure Sheets</td>
</tr>
<tr>
<td></td>
<td>Note: Multiple subsets may required for multiple Sites</td>
</tr>
<tr>
<td></td>
<td>Ex: 04_Structure_Br.No.1266</td>
</tr>
<tr>
<td>05-Traffic</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
</tr>
<tr>
<td></td>
<td>MPT</td>
</tr>
<tr>
<td></td>
<td>Traffic Signal Plans</td>
</tr>
<tr>
<td></td>
<td>Etc.</td>
</tr>
<tr>
<td>06-Environmental</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Environmental Compliance Sheets required</td>
</tr>
<tr>
<td>07-&quot;Utility&quot;</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
</tr>
<tr>
<td>08-CL&amp;P FIO***</td>
<td>CL &amp; P For Information Only plans</td>
</tr>
<tr>
<td>09-AT&amp;T FIO***</td>
<td>AT &amp; T For Information Only plans</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>* CTDOT Highway Design Standard Index and Sheets required</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>* CTDOT Traffic Engineering Standard Index and Sheets required</td>
</tr>
</tbody>
</table>

Figure 16 Typical Highway Project Discipline Subset Contents

* For using CTDOT Standard Sheets see 1.5 CTDOT Standard Sheet Assembly
** If a discipline has to be broken up into more than one subset See Section 1.11 for splitting up the discipline subsets.
*** For Information only discipline subset shall be submitted as individual pdf files based on the entity providing the information only.
1.11 Example: Multiple Volume Digital Contract

Multiple volumes are used if the project has 1 or more of the following characteristics:

1. The majority of the discipline/firm designers are responsible for more than 3 subsets each. This allows the individual designers to number their subsets independently of the other disciplines.

2. There are multiple sites on the project. Splitting these sites up into volumes will provide better organization of the project.

3. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more specific. The Project Manager will need to organize the discipline volumes. The subsets shall be split up by volume and each volume shall be controlled by its assigned designer. For example, all the subsets designed by the highway designer shall be in the same volume (02) and each subset shall have a unique subset number. For example, see subset 02.02_Alignments and 02.03_Plans as shown below.

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
<th>Designer/Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.01-General</td>
<td>Title Sheet, Detail Estimate Etc</td>
<td>Lead</td>
</tr>
<tr>
<td>01.02-Revisions</td>
<td>Index of Revision Sheets</td>
<td>Lead</td>
</tr>
<tr>
<td>01.03-Wldnd Re-establish</td>
<td>Wetland Reestablishment plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>01.04-Stg Acc.</td>
<td>Staging and Access Plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>02.01-Typ Sections</td>
<td>Typical Sections</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.02-Alignments</td>
<td>Alignment Geometry</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.03-Plan</td>
<td>Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.04-Profiles</td>
<td>Profiles</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.05-ROW Brk</td>
<td>Right of Way Breakout</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.06-Drain</td>
<td>Drainage Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>03.01-Retaining Wall 1</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.02-Retaining Wall 2</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.03-Bridge 00456</td>
<td>Bridge_456</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.04-Bridge 01983</td>
<td>Bridge_1983</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.05-Bridge 01984</td>
<td>Bridge_1984</td>
<td>Designer 3</td>
</tr>
<tr>
<td>04.01-Stage 1</td>
<td>Stage Construction Details 1</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.02-Stage 2</td>
<td>Stage Construction Details 2</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.03-Stage 3</td>
<td>Stage Construction Details 3</td>
<td>Designer 4</td>
</tr>
<tr>
<td>05.01-SPM</td>
<td>Signing and Pavement Marking Site 1</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.02-SPM</td>
<td>Signing and Pavement Marking Site 2</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.03-SPM</td>
<td>Signing and Pavement Marking Site 3</td>
<td>Designer 5</td>
</tr>
<tr>
<td>06.01-IMS</td>
<td>IMS Plans and Details Site 1,2,3</td>
<td>Designer 6</td>
</tr>
<tr>
<td>07.01-Env 1</td>
<td>Environmental Details Site 1</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.02-Env 2</td>
<td>Environmental Details Site 2</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.03-Env 3</td>
<td>Environmental Details Site 3</td>
<td>Designer 7</td>
</tr>
<tr>
<td>08.01-&quot;Utility“</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.01-CL&amp;P FIO</td>
<td>CL &amp; P For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.02-AT&amp;T FIO</td>
<td>AT &amp; T For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>* CTDOT Highway Design Standard Index and Sheets required</td>
<td>Designer 1</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>* CTDOT Traffic Engineering Standard Index and Sheets required</td>
<td>Designer 5</td>
</tr>
</tbody>
</table>

Figure 17 – Multiple Design Firms CTDOT Project Subsets
1.11.1 Combining Multiple Projects

When 2 or more projects are combined into one project, the following shall be done:

- Each project shall be given its own volume.
- The lowest project shall always be volume 1.
- Each project shall have its own title sheet, which reference each other with a note.
- There shall only be (1) Revisions subset. This subset shall be in volume 1 and named 01.02 – Revisions.
- The Revisions subset shall be the responsibility of the project manager on the projects.
- Each project shall have its own detailed estimate sheets.
- There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when the projects are combined.
- There shall not be any duplicate special provisions after the projects are combined.

1.12 Set Files

Bluebeam version 11 has a feature called Sets that allows all the discipline subsets to be viewed as if they are a single document, without actually combining all the files. The set file places all the discipline subsets plan sheets in the correct order by using the page label that is assigned during the sheet numbering process when the discipline subsets are prepared.

The project manager shall create a Set file for the project at FDP that contains all the discipline subsets, with the exception of the highway and traffic standard subsets. When an Addendum or Change Order is required for the project, the set file shall be updated by the project manager to include the Addendum or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of a project.

See Appendix C for general use of a set file.

1.12.1 When a Set File is Created and Updated

Set File Creation

1. The lead designer shall create a set file of all the discipline subsets at FDP, see section 1.12.2

Set File Updates

2. If any FDP subsets need to be revised during the DCD process, the set file shall be updated to remove the FDP subsets that were changed and add the DCD subsets.
3. If any Addendum subsets are required for the project, these Addendum subsets shall be added to the set file.
4. If any Design Imitated Change Order subsets are required for the project, these Design Imitated Change Order subsets shall be added to the set file.

See section 1.12.3 for updating the set file.
1.12.2 Creating a Set File

After all the discipline subsets have been submitted into Projectwise for FDP the lead designer shall create the project’s set file in accordance with the following:

1. Launch Bluebeam from the desktop icon on your computer.
2. Next Click on the Set Icon and select New Set as shown below:

![Image of Bluebeam software with instructions to create a set file](image-url)
3. Then click Add and then Projectwise and OK as shown below:

![Image](image1.png)

**Figure 19 - Adding Files to the Set File**

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except the standard subsets. Then click Open: After you click Open it may take a minute for Bluebeam to load all the files into the set, please be patient.

![Image](image2.png)

**Figure 20 - Adding Files to the Set File**
5. Next Click on Relative Paths and make sure the options are selected as shown below:

![Figure 21 - Set File Options](image1.png)

6. Next click on Advanced, type in ?# and select the options as shown below:

![Figure 22 - Configuring the Set File](image2.png)
7. Next click Save, this may take a while depending on how big the project is, please be patient. When the box pops up choose Projectwise and click OK:

Figure 23 - Saving the Set File
8. Select the Advanced Wizard, and then on the Select target folder browse out to your project’s 100_Contract_Plans folder. Then click next until you get to the attributes page. Attribute the Set File as shown below:

![Diagram of Advanced Document Creation Wizard]

(1) Select these attributes
(2) Type the label as "00-Consolidated Set" and make the description include what the set is updated to.
(3) Click Next until the document uploads

Figure 24 - Attributing the Set File

9. Click OK after the set file has been saved into Projectwise:

![Diagram of Set File Creation]

Click OK

Figure 25 - Creating a Set File
10. Now the set file has been created for use of the Set File see Appendix C:

![Figure 26 - Set File](image)

*All the files will be shown here in the correct order*
1.12.3  Updating a Set File

The following will show how to update a set file.

1.12.3.1  Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.
2. Next click on the Set icon and click Add as shown below:

Figure 28 - Modifying a Set File

3. Next browse out to your project and select the files to add to the set and click Open. This may take a minute to add the additional file to the set so please be patient. After it finishes click OK.

Figure 29 - Adding Files to the Set File
4. Now the file will be added to the set, scroll down and you will see it.

Figure 30 - Set File
1.12.3.2 Deleting a File from the Set

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Opening a Set File](image-url)

Figure 31 - Opening a Set File
2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

![Figure 32 - Deleting a File from the Set File](image-url)

Note: You can make the width of the file name column wider by dragging the column here.

Select file to delete and select delete, then click OK.
Section 2  Digital Signatures for Contract and Other Engineering Documents

The follow contract documents must be digitally signed when submitted to the Department in accordance with the following section:

- Contract Plans – FDP, Addendum, Change Orders
- Engineering Reports
  - Hydraulic Report
  - Scour Report
  - Floodway Report
- Working Drawings for Permanent and Temporary Structures – Plans and Calculations

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. The Engineer of Record will always digitally sign using a visible certifying signature. If multiple signatures are required per document, the sub-engineers shall always digitally sign using a visible signing signature after the primary engineer has applied his certifying signature. Certifying signatures allow controlled changes, to the now certified document. These controlled changes include; allowing PDF digital comments, and the application of additional signatures. Signing signatures should always be accompanied by a note listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the first sheet of each discipline subset(s), engineering report, or contractor submittal, regardless of the number of pages the document contains. This single digital signature secures the entire document.

A graphic image of the signer’s PE stamp and signature must be created, and shall be used for the following purposes.

- It shall be attached to the digital signature and displayed when the digital signature is applied.
- It shall be placed as a watermark on all contract plan sheets a particular engineer of record is responsible for (digitally signing for).
- It shall be placed on the first sheet by the preparer and checker of an engineering report.
- The watermark shall be placed on all contract plan sheets and all plan sheets contained in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the specifications of Adobe’s Certified Document Services (CDS). The necessary hardware and software needed to apply the required digital signatures may be purchased from the vendor list provided at the following website: http://www.adobe.com/security/partners_cds.html, additional information on Adobe’s CDS is also available at this website.
2.1 Graphic Image of Signature

2.1.1 Contract Plans

The following figures display an example of both a state designer and a consultant designer’s digital signatures, and their accompanying graphic image(s) of their signature(s).

The consultant engineer’s graphic image must contain his companies name and address; his signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state employee’s graphic image must contain only his signature. See Below.

Figure 33 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages be watermarked with a copy of the engineer of records graphic signature before they are digitally signed. Watermarks containing these signatures are applied using Bluebeam and are always placed in the border of contract plans and working drawings for permanent structures. This is to prove validation of a digital document if printed.

Figure 34 – Watermarks
2.1.2 Engineering Reports

The following shows the watermarks that need to be placed on the first sheet of an Engineering Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic Engineer.

Figure 35 - Engineering Reports
2.1.3 Working Drawings

**Working Drawings for Permanent and Temporary Structures**
The following shows the digital signature and PE watermark requirements for the engineer who prepares the working drawing submittal. Note: Working Drawing for Temporary Structures only require that the first sheet in the submittal be digitally signed, watermarks are not necessary.

**Working Drawing Plans**
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as shown below. All others sheets will only have the watermark. A place in the border of the plan sheets shall have a spot for this watermark.

![Figure 36 - Working Drawing for Permanent Structures](image-url)
**Working Drawing Calculations**

The first sheet of the calculations shall have a digital signature as shown below:

![Image of digital signature]

**Figure 37 - Working Drawing for Permanent Structures**

### 2.2 Creating Graphic Image of Signature:

#### 2.2.1 In House CTDOT Signature:

The graphic signature will be used by CTDOT employees and the preparer and Checker of an Engineering Report. P.E. stamps are not required.

The following CTDOT employees need to create graphic images of their signatures: Principal Engineer (required to digitally sign plans), Manager of State Design, and the Engineering Administrator. CTDOT graphic signatures shall be created as follows:

1. Signer must sign a blank piece of paper.
2. Scan this signature.
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
4. Save the images, in PDF to an area on your PC.

![Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark]

**Figure 38**

### 2.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall accompany their digital signatures and a different one that shall be placed as a watermark on all the sheets the designer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their signature; Architect’s shall follow this section when they are preparing their digital signature.
Graphic Appearance Attached to Digital Signature

The graphic signature that accompanies the digital signature only needs to include the designer’s signature and P.E. Stamp, and shall be created as follows:

1. Stamp and Sign a blank piece of paper.
2. Scan this signature.
3. Crop the image to approximately 250 pixels wide by 250 pixels high.
4. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the signature set-up procedure.

Figure 39 ((Example of Consultant Engineer Graphic image of Signature – Applied to 1st page only with digital signature)

Graphic Appearance used as a Watermark

In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a watermark shall also include the designer’s company name and address, and shall be created as follows:

1. On blank paper – Print company name and address.
2. Place P.E. stamp next to company name and address.
4. Scan the image created in steps 1 thru 3 above.
5. Crop the image to approximately 500 pixels wide by 250 pixels high.
6. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the watermarking procedure.

Figure 40 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature appearance preferences must be set as follows:
2.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be defined as follows:

**Bluebeam Digital Appearance**

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the Document tab and select Signatures>Digital ID’s:

![Image of Bluebeam interface with Document tab highlighted and Digital IDs option selected]

2. Next click on your ID and click Manage Appearances:

![Image of Bluebeam interface with Manage Digital IDs option selected]

(1) Select ID

(2) Click Manage Appearance

(3) Double Click

![Image of Bluebeam interface with Manage Appearances window open]

Figure 41 - Digital Appearance

Figure 42 - Manage Appearances
3. Next follow the figure below:

![Signature Appearance dialog box]

- **Type in name**
- **Browse to graphic**
- **Appearance**
- **Make sure these settings are like shown**
- **Click**

**Figure 43 - Setting the Digital Appearance**

4. Now the digital appearance will be saved and can be used to digitally sign.

### 2.4 Watermarking Plans with Graphic Image of Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a copy of their graphic signature as a watermark on each sheet of each discipline subset, or working drawing submittal (Plans and Calculations) that they are responsible for. For Engineering Reports the preparer and checker of the report shall place a copy of their graphic signature as a watermark **only on the cover** of the report.

**Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant Designed)**

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The following shows an example of a CTDOT signature, but the procedure is the same for a consultant when they are placing their PE stamp in the border or on the first sheet of an engineering report.

**Watermarking Workflow:**

**Option 1**

1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not in the list follow **Appendix A**. If your stamp is in the list go to step 2.
2. Next Place the stamp in the border on the first sheet.

Place stamp in this area in the border

Figure 44 - Placing Watermark

3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an engineering report you do not need to apply to all pages.

Figure 45 - Placing Watermark on All Pages

If more than one group has to watermark this subset, browse to the pages the other group is responsible for and delete the watermark. Then they can come in a place their watermark on these sheets.

Flatten Markups

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.
Option 2

1. Go to the Document tab and Pages>Apply Stamp.

![Figure 46 - Applying Stamps](image)

2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

![Figure 47 - Applying Stamps](image)

** Flatten Markups **

3. After the watermarks have been placed on the subset, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.
2.5 Digital Signature Fields

**Contract Plans**
Digital signature fields are form fields created using Bluebeam, and are used to house the digital signatures. Digital Signature form fields shall be placed within the form field place holders. The form field place holders are cells that are placed in the MicroStation file on the title sheet and the subset cover sheets and on any Addendum or Change Order Subset. The figure below shows a CTDOT designed project with the form field place holders (circled) on the title sheet and the discipline subset cover sheet.

![Figure 48 - Digital Signature Fields](image)

The figure below shows a consultant designed project’s title sheet and discipline subset cover sheet with their form field place holders.

![Figure 49 - Consultant Watermarks](image)

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: [CT_Digital_Sigs.zip](#)

The digital signature place holder and form fields shall be created on the first page of each discipline subset for each required digital signature.

**Note:** All signature form fields need to be created for both certifying and signing signatures before any digital signatures is applied to the document.

**Contractor Submittals**
Contractor submittals will not be required to have a digital signature place holder.

**Engineering Reports**
Engineering reports will not be required to have a digital signature place holder.
2.5.1 Bluebeam - Creating Digital Signature Form Fields

The following example shows how to place the (3) digital signature form fields on the 01-General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed 01-General title sheet, only one digital signature form field needs to be placed.

1. Go to the Document tab and select Signatures>Add Signature Field.

![Figure 50 - Adding Signature Fields](image)

2. Next place three signature fields in the appropriate location and hit save as shown below:

![Figure 51 - Placing Signature Fields](image)
2.6 Applying Digital Signatures

This section describes how to apply digital signatures for contract plans, engineering reports, working drawing plans, and working drawing calculations.

**Contract Plans**
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded into projectwise because the Principal Engineer will be looking in projectwise to digitally sign documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of record, using a single visible **certifying** signature, applied to the signature form field located on the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of Record who is responsible for the most sheets in the subsets. This engineer will apply a visible **certifying** signature in the top most form field. The next Engineer of Record shall apply their **signing** signatures in the subsequent form fields. This Engineer shall also include a reason, when applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital form fields, previously created. See Section 2.5

**Engineering Reports**
Engineering Reports shall be digitally signed, by the CTDOT Approved Hydraulic Engineer using a **certifying**. See section 2.7, for instructions on how to apply a certifying signature to an engineering report.

2.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead discipline’s Principal Engineer, using a **certifying signature**. The Principal Engineer should make sure that all three digital signature form fields (blue boxes in the signature block) are placed before signing, as these forms cannot be added after the document is digitally certified. After processing has approved the 01_general subset for Advertising, the Manager, and the Transportation Engineering Administrator shall digitally sign the same sheet directly below the principal’s signature, using a **signing signature** while the plans are in the **Manager and Engineer Admin. Sign** state.

Processing shall notify the lead designer when the 01-General subset is placed in the **Manager and Engineer Admin. Sign** state. The lead designer shall then coordinate the digital signing by the Manager and Engineering Administrator of the 01_General subset. When both signatures are applied to the plans, the lead designer shall then notify processing that the 01-General subset has been signed.

See Section 2.7 Applying Digital Signature Workflows
Note: When digitally signing the 01_General subset all signers shall leave the reason code blank.
The following image shows a typical project title sheet from the 01_General subset that is digitally signed:

**Figure 52 - Title Sheet Digital Signatures**

<table>
<thead>
<tr>
<th>Visible Certifying Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible Signing Signature</td>
</tr>
<tr>
<td>Visible Signing Signature</td>
</tr>
</tbody>
</table>

**CONSULTANT DESIGNED PROJECTS:**
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, using a certifying signature.

**See Section 2.7 Applying Digital Signature Workflows**

When more than one consultant works on a CTDOT digital project the project manager (prime consultant) shall apply a visible certifying signature to the first page of the 01_General subset. By applying this signature the prime consultant is accepting responsibility for the entire set of digital contract plans. However the individual subsets shall be signed by the corresponding firms.

**Note:** When applying certifying or signing signatures leave the reason code blank.
2.6.2 Applying a Digital Signatures to 02_Revisions Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 2.7 Applying Digital Signature Workflows with the following EXCEPTION; the option “No Changes Allowed” must be selected to eliminate unauthorized changes after certifying the document. See the figure below:

![Certifying Dialog Box for 02_Revisions.pdf](image)

Figure 54 Certifying Dialog Box for 02_Revisions.pdf
2.6.3 All Other Discipline Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the responsible design engineer. As shown below.

See section 2.7 Applying Digital Signature Workflows

2.6.4 Standard Drawing Subsets – Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to be digitally signed with a visible certifying signature, by the responsible design engineer that submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the index sheets, not the Highway Principal Engineer.

See section 2.7 Applying Digital Signature Workflows

2.6.5 All Other Discipline Subsets – Multi-Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same for CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall digitally sign the subset using a certifying signature, and leave the reason code blank. See Section 2.7 Applying Digital Signature Workflows
Once certified by the subset lead, the remaining designer(s) shall digitally sign the same subset using a signing signature, and complete the reason code with a note stating which pages, contained in this subset, that they are responsible for. See table 2-1 below:

See Section 2.7 Applying Digital Signature Workflows

<table>
<thead>
<tr>
<th>Designer</th>
<th>Certify or Sign</th>
<th>Responsible Sheet Numbers</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead Designer</td>
<td>Certify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub-Designer 1</td>
<td>Sign</td>
<td>03.78 Thru 03.88</td>
<td>I am Signing for Sheet Nos. 03.78 thru 03.88</td>
</tr>
<tr>
<td>Sub-Designer 2 – etc.</td>
<td>Sign</td>
<td>03.88 Thru 03.98</td>
<td>I am Signing for Sheet Nos. 03.88 thru 03.98</td>
</tr>
</tbody>
</table>

2.6.6 Working Drawings
Working drawing submittals shall be digitally certified in accordance with section 2.7 Visible Digital Signature using a Certifying signature, of this manual.

2.6.7 Engineering Reports
Engineering Reports shall be digitally signed, by the CTDOT Approved Hydraulic Engineer using a certifying. See section 2.7, for instructions on how to apply a certifying signature to an engineering report.
2.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature, but the workflows are the same.

Certifying Signature:
1. Left click on the signature field and then update the settings as shown below. Examples below are for a CTDOT designed project’s title sheet and the first sheet of an Engineering Report:

**Discipline Subsets**

![Image of Discipline Subsets]

**Engineering Reports**

![Image of Engineering Reports]

---

**Figure 56 - Certifying Discipline Subsets**

**Figure 57 - Certifying Engineering Reports**
2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Save To dialog box](image)

**Figure 58 - Certifying Signature**

3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![ProjectWise Overwrite File dialog box](image)

**Figure 59 - Certifying Signature**

4. If using Projectwise check the document back into Projectwise.
Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be applied by the sub-consultants as follows:

1. Left click on the signature field and then update the settings as shown below:

![Digital Signing Signature](image1)

![Digital Signing Signature](image2)

**Figure 60 - Signing Signature Bluebeam**

2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Open from Projectwise](image3)

**Figure 61 - Open from Projectwise**
3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![Figure 62 - Overwriting a File](image)

4. If using Projectwise check the document back into Projectwise.
Section 3  Submitting Documents to CTDOT Projectwise

The following documents must be submitted into CTDOT’s Projectwise database and attributed in accordance with this manual.

If two or more projects are being combined into (1) project, all contract documents for these projects will be submitted into the lowest numbered project in Projectwise.

CONTRACT PLANS (Discipline Subsets):

The CTDOT will consider all digital contract plans submitted to CTDOT as “official” contract documents; the engineer of record shall not alter these documents unless explicitly asked to by the CTDOT, and shall only alter what was requested. Consultant engineers submitting changes that were not requested or submitting requested changes outside the processes in this manual may be held liable for damages.

Check the following for completeness prior to submitting digital contract plans to the CTDOT. When submitting preliminary plans only step 1 is required to be performed. All steps shall be completed in accordance with this manual.

1. Project Manager should obtain the number of discipline subsets and notify each discipline of their subset number for sheet numbering. FIO subsets shall be last.
2. All pages of the discipline subsets are given a page label and contain a footer displaying the sheet numbers.
3. All pages of the discipline subsets display a graphic signature of the engineer of record (watermark) and this watermark is flattened to the PDF document.
4. The first sheet of each discipline subset shall be digitally signed by the engineer(s) of record, and shall contain a list of drawings contained in that subset. In addition, the first page of the 01-General subset must contain a list of subsets contained in the project.
5. All sheets contained in any FIO subsets must be labeled, “For Information Only”

A discipline subset submittal checklist shall be completed and attached to each discipline subset, see section 3.1.
CONTRACT SPECIFICATIONS:
The Designer shall submit individual word documents for each specification into Projectwise, see section 3.2.7. Specifications shall be prepared in accordance with the Departments policies and procedures for Contract Development. CTDOT Processing shall combine all specifications into (1) PDF document for the contract.

SUPPLEMENTAL CONTRACT DOCUMENTS:
Supplemental contract documents shall include but not limited to the list below:
- Proposal Estimate, with signed checklist.
- Federal Estimate
- Calendar Day Estimate
- Final Design Report
- Categorical Exclusion
- Design Approval Letter
- Environmental Permits
- DBE/SBE Approval with percentage
- Commitment list
- Agreements
- Proprietary Item Approval
- Stand alone Transportation Management Plan Document, taken from the final design report

These documents shall be submitted to CTDOT in PDF format, except the proposal estimate, this shall be in an “.est” format. If these documents do not need to be digitally signed, they may be signed and scanned into PDF, however the minimum page size shall be 8.5” x 11” and the minimum resolution shall be 200 dpi.

ENGINEERING REPORTS
The following final Engineering Reports with their associated data files shall be uploaded into Projectwise in accordance with section 3.2.
- Hydraulic Report and Hydraulic Report Data
- Scour Report and Scour Report Data
- Floodway Report and Floodway Report Data
3.1 Discipline Subset Submittal Checklist

The discipline subset submittal checklist shall be used by the engineer as a guide and verification that all the PDF post processing steps have been completed correctly.

The following link is to the Discipline Subset Submittal Checklist: Discipline Subset Submittal Checklist

This checklist shall be completed and attached to all discipline subsets when they are submitted into Projectwise. This includes FDP, DCD, ADP, ACD, or DCO submittals. Note: The 01-General is considered a discipline subset.

The following shows how to complete and attach the submittal checklist to each discipline subset, both normal subsets and standards subsets. A checklist does not need to be completed or attached to the 02-Revisions Subset:

An instructional video is also available here: Discipline Subset Submittal Checklist Procedure Video

Normal Discipline Subsets

1. Click on the link above and save the checklist to your computer.
2. Next attach the checklist to the subset as shown below:

   ![Figure 63 - Attaching the Submittal Checklist](image)

   1. Click on the attach document icon
   2. Select the checklist and click open to attach

3. Complete the tasks on the checklist and then type your name and a phone number in the lines provided.
4. Forward a link to the Engineer of Record for digital signing.
5. After the discipline subset has been digitally signed, open the discipline subset and apply the QA/QC stamp as shown below: Note if you cannot place the stamp the discipline subset was digitally signed incorrectly. If you do not have the stamp as shown below you must first import the Bluebeam User profile as shown in Appendix A.

Figure 64 - QA/QC Stamp
3.2 Projectwise

CTDOT is currently using Bentley’s ProjectWise as a data management software for digital projects. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available. Projectwise shall be used by all consultant engineers delivering digital contract documents.

3.2.1 ProjectWise

Consultant engineers may use either Projectwise thin client or Projectwise thick client. Thin client is a web based version of Projectwise, which does not require any software installations. All that is required to login to the appropriate webpage is a user name and password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is available. The thick client conversely requires the installation of the Projectwise client software. In addition to performing all the functions of thin client; thick client has the addition functionality:

- Delta file transfer – Improves speed of downloads
- Managed workspaces – Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Users can get Projectwise Thick Client for free if they have an active license of Microstation. Download Projectwise Client from Bentley using your select ID. Once Projectwise is installed on your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client

Users can get to our Projectwise Datasource using the following various applications. The table below lists the server URL for each application:

<table>
<thead>
<tr>
<th>Applications</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPAD</td>
<td>ctdot-ws.projectwiseonline.com/pwmobileaccess</td>
</tr>
<tr>
<td>Microsoft</td>
<td><a href="https://Ctdot-ws.projectwiseonline.com/ws">https://Ctdot-ws.projectwiseonline.com/ws</a></td>
</tr>
</tbody>
</table>

The following workflow shows how to log in and change your password: Projectwise Log in

If you do not have a Projectwise User name and password fill out the following form: ProjectWise New User Form

Consultant firms are usually given (2) user names that can be used by the whole firm. More than one person can use the user name at a time. It is the firm’s responsibility to manage the user name and password in cases where employees leave and work at another firm. This way the employee that leaves cannot use their old company’s user name and password.

3.2.2 Projectwise Folders for Contract Documents

This section gives directions on which folder contract documents will be submitted in Projectwise.

If two or more projects are being combined into (1) project, all contract documents for these projects will be submitted into the lowest numbered project in Projectwise.

100_Contract Plans (PDF) – This folder contains all Contract Plan Discipline Subsets. This includes all Final plans, Addendum plans, Design Initiated Change Order, As built, and FIO Plans.
110_Contract Specifications (PDF) – This folder contains the Final, Addendum, and Construction Order Requests Contract Specifications packages. The designer will NOT submit Final or Addendum specifications into this folder; they shall submit Final Specifications and Addendum contract specifications in word format, into the 240_Contract Development folder. The designer can only submit change order specifications into this folder.

CTDOT finalizes the FDP and Addendum Specification Packages into one PDF file and places the final package into this folder.

120_Contractor Submittals (PDF) – This folder contains all working and shop drawings submittals.

130.Engineering Reports – This folder contains all the final engineering reports.

140_GIS – This folder contains the project polygon and parcel polygon files and their associated kmz files.

210_Construction Folders
  • Construction Survey – This folder is still in development.
  • Office_Of_Construction – This folder is still in development.

220_FHWA – This folder is used for FHWA documents.

230_Contract Administration – This folder is used by CTDOT Contracts.

240_Contract Development – Designer shall submit the following supplemental contract documents into this folder:
  • All contract specifications and Notice to Contractors (NTC), in word format, both final and addendum specifications
  • Proposal Estimate
  • Federal Estimate
  • Calendar Day Estimate
  • Final Design Report
  • Categorical Exclusion
  • Design Approval Letter
  • Environmental Permits
  • DBE/SBE Approval with percentage
  • Commitment list
  • Agreements
  • Proprietary Item Approval
  • Standalone Transportation Management Plan Document, taken from the final design report

310_Review_Documents – The designer shall submit all non-final design documents into this folder. This includes plans, specifications, reports, estimates, Property Maps (pdf), etc.

320_Permit_Applications – This folder is still in development.

330_Design_Data – Under this folder is a folder for each discipline that is used for all their design documents.

340_Administration – The lead designer shall upload the following documents into this folder:
  • A 2-D Microstation file that contains a polygon showing the project limits.
500_Pre_Design Folders

- **01_Planning** – This folder is still in development.
- **02_Concepts** – This folder is still in development.
- **03_Central_Surveys** – This folder is still in development.
- **04_District_Surveys** – This folder is still in development.
- **05_Property_Maps** - CTDOT or Consultant Surveyors shall upload the following files into this folder:
  - Polygon ROW Parcel Microstation File (.dgn) for each affected parcel on a project.
  - Property Map (.dgn)
  - Final Property Map (pdf)

3.2.3 Uploading Documents - ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in ProjectWise, but this procedure can be followed for uploading documents into any folder in ProjectWise.

1. Once logged into ProjectWise browse out to project and folder you need to upload into. Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.
2. Next select Document>New as shown below:

![Figure 65 - Uploading Document into ProjectWise (Thin Client)](image)
3. Next browse out to the document you want to upload. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

Figure 66 - Thin Client Attributes
3.2.4 Uploading Documents – Projectwise (Thick Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in Projectwise, but this procedure can be followed for uploading documents into any folder in Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not shown go to View > Toolbars and select interface.

2. Drag and Drop files into the correct folder in the Project.

![Figure 67 - Uploading Into Projectwise (Thick Client)](image-url)
3. Select the “Advanced Wizard”
4. Click “Next” until you reach the figure below:
5. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

![Figure 68 - Attributing (Thick Client)](image)

7. On the create document page click next and the document will be uploaded into Projectwise.
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file name update.
3.2.5 Combining and Uploading Contract Specifications and CSI Special Provisions

For projects that are led by a consultant designer, FDP and Addendum Contract specifications and CSI Special Provisions shall be placed in (1) zipped folder. For projects that are led by a CTDOT design unit, FDP and Addendum Contract specifications and CSI Special Provisions shall be placed in individual zipped folders per discipline.

Addendum specifications shall be placed in (1) zipped folder and submitted into the 240 Contract Development Folder. Each page of the specification section shall be marked in the bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum number. Also a line shall be placed on the right side indicating where language was changed in the specification.

Design Initiated Change Orders specifications shall be placed in (1) PDF document and uploaded into the 110_Contract Specifications folder. Each page of the specification shall have a “C#” and the date in the bottom right corner of the footer. An example would be, “C1 - 01/01/13”. Also a line shall be placed on the right side indicating where language was changed in the specification.

The following shows an example of a consultant designed project, but the process shall also be followed for a CTDOT designed project.

See the figures below for how to zip a folder:
1. Place all specifications (word documents) in one folder.
2. Right click on the folder and select “Compress to” option shown below:

![Compress Spec. Folder](image)

Specifications shall be submitted in a zipped folder for every submittal into Projectwise. Submittals include FDP, revised FDP specifications, Addendum specifications, and revised addendum specifications. Revised FDP and addendum submissions shall only include the revised specifications.
**Submitting Contract Specifications**

Once logged into Projectwise the final contract specifications shall be submitted as follows:

1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Drag and Drop the zipped specifications folder into the 240_Contract Development Folder or the pdf of the change order specs into the 110_Contract Specifications folder.
3. Use the advanced wizard and then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.
4. Click next until the document is uploaded. The document name and file name will be automatically updated to match the CTCode when Projectwise is refreshed.

**3.2.6 Uploading Supplemental Contract Documents**

Once logged into Projectwise, the Final Design Supplemental Contract Documents shall be submitted and attributed into the 240_Contract Development folder as follows:

1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Drag and Drop the document into the 240_Contract Development Folder.
3. Use the advanced wizard and then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.
4. Click next until the document is uploaded. The document name and file name will be automatically updated to match the CTCode when Projectwise is refreshed.

If a supplemental document is revised, a new revised document shall be uploaded into projectwise with the addition of “Revised” being included in the Label.

The document name and file name will automatically update to match the CTCode when Projectwise is refreshed.

**3.2.7 CTDOT Contracts Finalizing of Contract Specifications**

CTDOT Contracts shall finalize the specifications working in the 110_Contracts_Specifications Folder following this workflow CTDOT Contracts Workflow.

**3.2.8 Notification of Submittals**

When Contract Plans, Specifications, and supplemental contract documents are submitted into Projectwise the applicable personnel must be notified as follows as applicable:

1. For consultant designed projects, the consultant will notify their Liaison Engineer, who will then notify, by memorandum, processing that contract plans or specifications have been submitted for review.
2. For state design projects, the project manager will notify, by memorandum, processing that contract plans and specifications have been submitted.
3.2.9 Contract Plans Workflow (FDP - Advertise)

Table 3-3 below shows how final digital design plans (FDP) flow from delivery through processing to their final state in advertising. Processing personnel shall use the following workflow: Projectwise for Processing.

<table>
<thead>
<tr>
<th>Step</th>
<th>Group</th>
<th>Responsibilities of Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Designer</td>
<td>- Submits FDP subsets into the 100_Contract Plans folder.</td>
</tr>
</tbody>
</table>
| 2    | Processing (CTDOT)             | - Change FDP subsets to the Processing State and digitally mark up with comments and save FDP plans. Keep FDP Plans in the Processing State. If there are no comments proceed to step 7.  
  - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder.  |
| 3    | Designer                       | - Change subsets to reflect comments made by Processing  
  - Submits DCD subsets |
| 4    | Processing (CTDOT)             | - Change DCD subsets to Processing state  
  - Perform a document compare on the FDP and DCD plans using Bluebeam.  
  - Digitally markup DCD subsets with comments and save. If there are no comments proceed to step 7.  
  - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder.  |
| 5    | Designer                       | - Change subsets to reflect comments made by Processing on DCD Plans  
  - Submits DCD2 subsets |
| 6    | Processing (CTDOT)             | - Changes DCD2 subsets to Processing state  
  - Perform a document compare on the DCD and DCD2 plans using Bluebeam.  
  - Digitally markup DCD2 subsets with comments. If there are no comments proceed to step 7.  
  - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder.  |
| 7    | Processing (CTDOT)             | - Change the Sub Category Attribute of the approved subset from FDP or DCD(1,2,.etc.) plans to FPL plans. STD and FIO plans shall not be change to FPL.  
  - Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a ".pdf" on the end.  
  - If is a CTDOT Design project, change all discipline subsets to the Manager and Engineering Admin. Sign State. Notify Designer they have to have Manager and Engineering Admin sign the title sheet. When the Designer notifies processing these signatures have been applied to the title sheet, change all discipline subsets to the Advertise state.  
  - If is a Consultant Designed Project, change discipline subsets to Advertise State.  
  - Delete all previous versions of plans, FDP, DCD, DCD2, etc.  
  - Keep Comment reports in the 240_Contract_Development folder for records if necessary  
  - Formally notify Contracts when all subset have been approved for Advertising  |

Table 3-1 Workflow for CTDOT Processing Unit (Contract Drawings)
3.2.10 ProjectWise Project folder Security

Through the use of Workflows and States, Projectwise can provide dynamic securities to a folder or document. Dynamic security allows a different level of security to each document at various phases of its life cycle. This allows a document to reside in one location, in Projectwise, throughout the project life cycle.

3.2.11 100_Contract_Plans (PDF) Folder (Dynamic Security)

During the design submittal process the Projectwise workflow, “Contract Plans Processing”, shall be applied to this folder. This workflow allows three different states (securities settings) to be applied to documents within this folder. Each state provides a unique security. The CTDOT Contracts Processing Unit shall determine which state a document in this folder shall be in.

The “Contract Plans Processing” workflow contains the following security states:

**Document Transfer State** – allows either the Consultant or State Designer to upload, read and alter a document.

**Processing State** – Allows only the processing unit read, write access, allowing them to review the documents in a secluded area. All other users shall have read access.

**Manager and Engineering Admin. Sign** – Allows the Manager and Engineering Administrator to sign the project Title sheet.

**Advertise State** - Allows all users file read access, allowing any user to open and read the document.

Once the contract is awarded to the low bidder (Contractor), the documents will move into a new workflow called “Contract Plans Construction” which hands control of the documents to the CTDOT Office of Construction (all offices).

The “Contract Plans Construction” workflow contains the following security states:

**Construction State** – allows construction to upload, read and alter a document. All other users shall only have file read.

**Perform As-Built** – allows construction to place as-built information on the plans. All other users shall only have file read.

**As-Built Complete** – All users will have read only when the documents are put in this state.
3.2.12 Changing the State of a Document

The designer and district construction will be required to change the state of documents for contractor submittals during the review process. To change the state of a document, follow the figure below:

1. Right click on the document that you want to change the state of, then select change state>change, as shown below:

![Image of changing document state](image-url)

**Figure 70 - Changing the State**
2. Next drag the file(s) from one state to another as shown below:

![Figure 71 - Changing the State](image)

3. Click OK when the comment window opens up and the documents state will change. Next close the change workflow state window.
4. Notice the “State” column, the state of the documents has been changed.

![Figure 72 - State has been changed](image)

3.2.13 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract plans and specifications for DOT Projects. This form is located in each project in Projectwise and each unit in the Department that needs paper copies of contract plans and specifications is required to update this form for their paper needs. This form is then used by the Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out using the information indicated on the form. Addendums will be printed and sent out automatically. When a Change Order is submitted, the designer must notify Engineering records that a Change Order has been submitted and that paper copies of the Change Order need to printed and sent to the applicable units indicated on the Paper Plan Order Form.
This following shows the procedure for how the Paper Plan Order Form is filled out and the prints are made.

Contact Information for Engineering Records:
Pascone Place: 860-666-6107 Plan Printing
Print Shop: 860-594-3086 Specification Printing

<table>
<thead>
<tr>
<th>Step</th>
<th>Project Stage/Submittals</th>
<th>Group</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FDP</td>
<td>Processing</td>
<td>After the contract plans and specifications have been submitted for FDP an email is sent to each unit in the Department that requires paper copies of contract plans and specifications.</td>
</tr>
<tr>
<td>2</td>
<td>FDP</td>
<td>Units</td>
<td>Open the Paper Plan Order Form from Projectwise and fill out the form for their unit’s needs. Save the form and check the form back into Projectwise.</td>
</tr>
<tr>
<td>3</td>
<td>DCD</td>
<td>Processing</td>
<td>At DCD, lock the form by placing it in the Processing state.</td>
</tr>
<tr>
<td>4</td>
<td>Advertise</td>
<td>Contracts</td>
<td>Notify Pascone place and the print shop that the project is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>5</td>
<td>Advertise</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>6</td>
<td>All Addendums</td>
<td>Contracts</td>
<td>Notify Pascone place and the print shop that an Addendum is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form for this Addendum. Make sure to tell Engineering Records which subsets are included in the Addendum.</td>
</tr>
<tr>
<td>7</td>
<td>All Addendums</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Addendum. Make sure to print all the subset that were affected by the Addendum including the 02-Revisions subset.</td>
</tr>
<tr>
<td>8</td>
<td>All Change Orders</td>
<td>Lead Designer</td>
<td>Option 1 - Notify Pascone place and the print shop that a Change Order has been submitted and they can print the required paper copies indicated on the Paper Plan Order Form. Make sure to tell Engineering Records which subsets are included in the Change Order. If a unit is not listed on the Paper Plan Order Form, give Engineer Records those units’ contact information so those units’ can receive a copy of the Change Order.</td>
</tr>
<tr>
<td>9</td>
<td>All Change Orders</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Change Order and for any other units’ requested by the Lead Designer. Make sure to print all the subsets that were affected by the Change Order including the 02-Revisions subset.</td>
</tr>
</tbody>
</table>

Issued 01-2015 73 Version 3.08
Section 4  Contract Plan and Specification Revisions (Addenda and Design Initiated Change Order)

4.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted shall not be included in the Addenda submittal. The first sheet of each addendum subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 2.0 of this manual, DO NOT ADD an index of drawings sheet. Once digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section 3.0 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise (See Section 3.0): The addenda subset shall have the same label as the original final plan subset with the addition of (_A##) added to the end, where the ## equals the addenda number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See example below:

**PROJECTWISE LABEL ATTRIBUTE**

<table>
<thead>
<tr>
<th>Original Discipline Subset:</th>
<th>04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addenda Discipline Subset:</td>
<td>04-Traffic_A01</td>
</tr>
<tr>
<td>2nd Addenda</td>
<td>04-Traffic_A02</td>
</tr>
<tr>
<td>6th Addenda</td>
<td>04-Traffic_A06</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing the addenda stamp. For this process see Section 4.4.

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the project manager for all addenda, and submitted as described in Section 4.3.1. A new subset must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all added or revised sheets. See Section 2.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent to all applicable units following section 3.2.13.
4.1.1 Revised Plans - Addenda

**Microstation Processes**

A note shall be placed, directly above the bottom right hand corner of the title block, on the replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be **clouded** and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per addenda. If a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is changed again under addenda 7 the revision number becomes 2.

**Note:** If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a clear manner, do not void out the existing sheet and create a new sheet. In these instances, the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a "Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General Plan sheet for any structure is never to be revised.

**Bluebeam Processes**

Sheet numbers for revised plans shall be as follows:

Original Final Plan Sheet;

- Original: 02.25
- Addenda 1: 02.25.A1

Previous Addenda Sheet;

- Original: 02.25.A2
- Addenda 4: 02.25.A4

If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam after addendum approval, see Section 4.4.

4.1.2 New Sheets - Addenda

**Microstation Processes**

Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline subset, the new sheet shall be placed last, and numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO. "Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited. The revision block on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the discipline subset, the new sheet number shall be the number of the previous sheet
followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet must be placed in a discipline subset right after sheet 02.57, the new sheet shall be numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 02.57-2.A1. The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet number the drawing number of the new sheet shall be the drawing number of the previous sheet plus a decimal and the sheet count. For example, if the new drawing must be placed in the project plans right after drawing number S-5, the drawing number shall be S-5-1.

Bluebeam Processes
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;
Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;
Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;
Original: 05.14-1.A1
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;
Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;
Original Last Sheet: 04.31
Addenda 3: 04.32.A3

4.1.3 Adding New Subset – Addenda
The new subset shall be submitted by an Addendum and be prepared the same way as an FDP discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the sheets stating “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addendum number. This note is a level in Microstation that needs to be turned on and edited. The label attribute on the new subset shall contain an "_A##". The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.
4.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted; but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY ADDENDUM NO."Y"; where "Y" equals the addendum number. See Section 4.4

4.1.5 Addenda Plans Workflow

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings below shows how addenda subsets are delivered and processed for advertisement.

<table>
<thead>
<tr>
<th>Step</th>
<th>Group</th>
<th>Responsibilities of Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Designer</td>
<td>- Submits ADP subsets into the 100_Contract Plans folder.</td>
</tr>
<tr>
<td>2</td>
<td>Processing (CTDOT)</td>
<td>- Changes document to the Processing State and digitally mark up with comments and save.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Keep ADP Plans in the Processing State. If there are no comments proceed to step 7.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a comment report of these comments and save on your computers desktop. Then</td>
</tr>
<tr>
<td></td>
<td></td>
<td>upload and attribute this report correctly into the 240_Contract_Development folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Notify the designer when this is finished.</td>
</tr>
<tr>
<td>3</td>
<td>Designer</td>
<td>- Change subsets to reflect comments made by Processing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Submits ACD Subsets</td>
</tr>
<tr>
<td>4</td>
<td>Processing (CTDOT)</td>
<td>- Changes ACD subsets to Processing state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Perform a document compare on the ADP and ACD plans using Bluebeam.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Digitally markup ACD subsets with comments. If there are no comments proceed to step 7.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a comment report of these comments and save on your computers desktop. Then</td>
</tr>
<tr>
<td></td>
<td></td>
<td>upload and attribute this report correctly into the 240_Contract_Development folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Notify the designer when this is finished.</td>
</tr>
<tr>
<td>5</td>
<td>Designer</td>
<td>- Change subsets to reflect comments made by Processing on ACD Plans</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Submits ACD2 Subsets.</td>
</tr>
<tr>
<td>6</td>
<td>Processing (CTDOT)</td>
<td>- Change ACD2 Subsets to Processing state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Perform a document compare on the ACD and ACD2 plans using Bluebeam.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Digitally markup ACD2 subsets with comments. If there are no comments proceed to step 7.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a comment report of these comments and save on your computers desktop. Then</td>
</tr>
<tr>
<td></td>
<td></td>
<td>upload and attribute this report correctly into the 240_Contract_Development folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Notify the designer when this is finished.</td>
</tr>
<tr>
<td>7</td>
<td>Processing (CTDOT)</td>
<td>- Change the Sub Category Attribute of the approved subset from ACD(1,2,..etc.) plans to ADP plans</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a &quot;.pdf&quot; on the end.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Change discipline subsets to the Advertise State.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Delete all previous versions of plans, ADP, ACD, ACD2, etc.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Keep Comment reports in 240_Contract_Development folder for records if necessary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Formally notify Contracts when all subset have been approved for Advertising</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Notify the designer that the plans are going to be advertised and they can put the addenda stamps on the affected sheets.</td>
</tr>
</tbody>
</table>
4.1.6 Addenda Specifications

Contract Specifications that are revised or added due to addenda shall be submitted digitally in accordance with section 3.2.5.

4.1.7 Addenda Report

Addenda report shall contain all the changes to the plans and specifications and any contractor questions and answers. This report shall be submitted in Word format into the 240_Contract_Development in Projectwise with the following attributes:

Discipline = CT
Main Category = DOC
Sub Category = RPT
Label = “Addn. No. # Report”, where # is the addendum number. If a report is revised the label shall include “Rev.” at the end. If the report is revised a second time the label shall include “Rev. 2” at the end, etc.
Description = Give a brief description of the submission.

4.1.8 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow section 1.8 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

4.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the original contract by:

- A revision to an existing plan sheet(s) or specification(s)
- The addition of a new plan sheet(s) or specification(s)
- The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF discipline subset(s) containing only the added or changed sheets. The sheets being revised or deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 2.0 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO subset(s) shall be submitted to the CTDOT, using Projectwise as described in Section 3.2 of this manual.

DCO sheets from different subsets cannot be combined and submitted as one subset.

The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See Section 3.0): The DCO subset shall have the same name as the original final plan subset with the addition of (_C###) added to the end, where the ### equals the DCO number. The sub-category attribute shall be DCO (Design Initiated Change Order) See Examples below:
The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet with a red X and adds the following note; “THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy; where “Y” equals the Design Initiated Change Order number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing stamp. For this process see Section 4.4

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for all DCO, and submitted as described in Section 4.3.2. This includes DCO’s that affect plan sheets as well as any DCO’s that do not affect the plan sheets. Any DCO that does not affect a plan sheet shall be recorded on the 02-Revisions set stating, “No Change to Plans”.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all DCO sheets. See Section 2.2

Paper copies for all change orders will be requested and sent to all applicable units’ following section 3.2.13.

4.2.1 Revised Sheets – DCO

Microstation Processes
A note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per change to the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Any details to be deleted shall be crossed out with an “X” on the revised sheet. Details shown on the original PDF, but no longer required, shall not be deleted on the revised PDF, but shall be crossed out. Engineering judgment must be used to produce clear and concise information for the contractor.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp (Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 2 of this document.

4.2.2 New Sheets – DCO

**Microstation Processes**

Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline subset, the new sheet shall be numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the title block. This note is a level in Microstation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the bottom right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number of the new sheet shall be the drawing number of the sheet it most closely relates to followed by (-#). For example, if the new drawing must be placed in the project plans right after drawing number HWY-10, the drawing number shall be HWY-10-1.
Bluebeam Processes

Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
  Original: 04.31
  DCO 3: 04.31-1.C3

Previous Addenda – Added Sheet;
  Original: 03.24.A1
  DCO 4: 03.24-1.C4

Previous DCO – Revised Sheet;
  Original: 02.45.C1
  DCO 2: 02.45.C2

Previous Addenda - Added Sheet;
  Original: 05.14-1A1
  DCO 2: 05.14-2.C2

Previous DCO – Added Sheet;
  Original: 02.45-1.C1
  DCO 2: 02.45-2.C2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus C#, where # equals the Design Initiated Change Order Request number.

Original Final Sheet

  Original Last Sheet: 04.35
  DCO 4: 04.36.C4

4.2.3 New Subset – DCO

The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited. The label attribute shall contain “_C#”’. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

4.2.4 Voided Sheets

Sheets submitted within final design plan subsets, addenda subsets, or design initiated change order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 4.4

4.2.5 DCO Specifications

Specifications shall be created in accordance with the Departments policies and procedures for Contract Development. The Engineer shall also combine all specifications into (1) PDF document and upload that into the 110_Contract Specifications (PDF) folder in Projectwise following section 3.2.5.
4.2.6 DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the following.

The DCO for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow section 1.8 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

4.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded from these links:

CTDOT Designed Projects - 02-Revisions Subset
Consultant Designed Projects - 02-Revisions_CE_Subset

Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP) and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions subset starts out as an un-signed blank place holder in the project. The figure below is an example of a blank 02-Revisions subset:

![Figure 73 - Blank 02-Revisions Subset](image)

**ADDENDA:**

When the project requires an Addendum, the Project Manager must record these changes on a **NEW** 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets shall contain all previous Addendum information. For example, Addendum 4 shall include all changes made from Addendums 1, 2, 3 and 4.
Note: A New 02-Revisions subset is required for each addendum because there are times when multiple addendums are being submitted to processing for the same project. An example of this is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum revision sheets must be submitted.

DESIGN INITIATED CHANGE ORDER:

When a project requires a Design Initiated Change Order (DCO), the following process shall be followed:

For each DCO, the Project Manager shall AMEND the 02-Revisions subset. The 02-Revision subset shall always contain all previous Addendum information and the new DCO information. For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to Addendum #3:

![Figure 74 - Index of Revisions Sheet](image)

Detail A from figure 1 shows the information typed in for a change to the contract plans. The project designer inputs the Addendum or DCO number, the sheet number, the date, a description of the change, the person who made the change, and checks the appropriate box for: new sheet added, revised sheet or deleted sheet.
4.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:

3. Enter the information into form fields as described in section 4.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the title block, where Y = the Addendum number.
5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow section 4.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 2.6.2

7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-Revisions_A##

9. Make the document description 02-Revisions_A##.

### 4.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. Follow steps 2 through 7 from section 4.3.1 amended as follows:
   a. In step 4 edit note “DESIGN INITIATED CHANGE ORDER NO. Y - mm/dd/yy”
   b. In step 5 add note “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy”
   c. In step 7 “Check In” the document into Projectwise

### 4.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 1.4 step 16.

2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block information and update the sheet accordingly.

### 4.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the Addendum or Design Initiated Change Order. The second column is the revised or new sheet number. The third column is the date, followed by a brief description that is similar to the description on the actual sheet being revised. Finally click in the appropriate check box per row to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is not required to input changes numerically by Sheet No. If another changed sheet is added to an Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of Revisions Subset”.

<table>
<thead>
<tr>
<th>REV. No.</th>
<th>SHEET No.</th>
<th>DATE (dd/mm/yy)</th>
<th>NEW</th>
<th>REV. DEL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>02.06.003A1</td>
<td>01/01/11</td>
<td>✓</td>
<td></td>
<td>REMOVED DETAIL</td>
</tr>
<tr>
<td>A1</td>
<td>02.06.004A1</td>
<td>01/01/11</td>
<td>✓</td>
<td>DELETE</td>
<td>SHEET</td>
</tr>
<tr>
<td>A2</td>
<td>02.05.003A2</td>
<td>01/20/11</td>
<td>✓</td>
<td></td>
<td>REVISION DETAILS</td>
</tr>
<tr>
<td>A2</td>
<td>02.05.003A2</td>
<td>01/20/11</td>
<td>✓</td>
<td></td>
<td>REVISION DETAILS</td>
</tr>
<tr>
<td>A3</td>
<td>02.06.003-1A2</td>
<td>01/20/11</td>
<td>✓</td>
<td>DELETE</td>
<td>SHEET</td>
</tr>
<tr>
<td>C1</td>
<td>04.01.02A1</td>
<td>02/15/11</td>
<td>✓</td>
<td></td>
<td>WALL 101 DETAILS</td>
</tr>
<tr>
<td>C2</td>
<td>03.04.055-1C2</td>
<td>03/02/11</td>
<td>✓</td>
<td>DELETE</td>
<td>SHEET</td>
</tr>
</tbody>
</table>

**Figure 78 Modifying the “Index of Revisions Subset”**
4.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or in Markup>Stamps as shown below:

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see Appendix A – Bluebeam Stamps

WARNING – When placing the stamps, removing the digital signature is not allowed.

Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and as built notes. These notes should be used in conjunction with the cross-out stamp.

The following shows how to apply the stamp to the sheet that needs to be crossed out for an Addendum or Change Order.

1. Select the stamp from the Tool chest or Markup>Stamps and place it:
2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1 below in **all caps** as shown below:

![Add or CO Note](image)

Figure 81 - Enter Note for Addendum and Change Order Stamp

### Table 4-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts

<table>
<thead>
<tr>
<th>Addendum Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY ADDENDUM NO. Y</td>
<td>The revised sheet is considered to replace, in total, the original sheet.</td>
</tr>
<tr>
<td>VOIDED BY ADDENDUM NO. Y</td>
<td>Sheet is voided by Addendum.</td>
</tr>
<tr>
<td><strong>Design Initiated Change Order Notes</strong></td>
<td><strong>Description of Use</strong></td>
</tr>
<tr>
<td>THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Used for revisions to existing sheets. Changes must be noted only on the revised sheet.</td>
</tr>
<tr>
<td>VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Use this for voiding of existing sheets.</td>
</tr>
</tbody>
</table>
3. The following shows a completed stamp.

Figure 82 Typical Sheet Replaced by Addendum 1

Figure 83 Typical Sheet Replaced by DCO
Section 5 As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed over the top of the digital signature and its security, therefore, the original content of the PDF plans can never be altered. Because as-built comments are digital and placed over the top of the plans they are easily recognizable, searchable, and may be turned off if necessary.

As-built comments shall be applied to the original, addenda, or construction order plans, which every sheet is the latest, located in ProjectWise within the project’s 100_Contract Plans folder.

CAD drawings may be updated, at the discretion of each design office, to reflect any addenda, change orders, and as-built revisions for use in the future; however the original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set for permanent records.

5.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on their record set (paper copies) during construction. Once construction is completed these revisions shall then be applied as comments to the digital PDF per the workflow in section 5.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built revisions on their record set (paper copies), and shall apply them as comment to the final set of digital PDF plans on an intermittent bases, during construction. By using this method as-built information becomes available to all parties that have access to ProjectWise during the construction process, improving communication and transparency.
5.1.1 Post Construction As-Built

**As-Built Workflow**

<table>
<thead>
<tr>
<th>Step</th>
<th>Personnel</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chief Inspector</td>
<td>Notify the Contracting Engineer or Designated District Staff that As-Builds can be applied to the Contract Plans.</td>
</tr>
<tr>
<td>2</td>
<td>Contracting Engineer or District Staff</td>
<td>Change the state of the Contract Plans to “Perform As Built”, see Section 3.2.12</td>
</tr>
<tr>
<td>3</td>
<td>Contracting Engineer or District Staff</td>
<td>Apply As-Built revisions to the Contract Plans in accordance with Section 5.3</td>
</tr>
<tr>
<td>4</td>
<td>Contracting Engineer or District Staff</td>
<td>Change the state of the Contract Plans to “As Built Complete”, see Section 3.2.12</td>
</tr>
<tr>
<td>6</td>
<td>Contracting Engineer or District Staff</td>
<td>Notify all applicable personnel list in the Section 5.4.2 that the As-Builts have been completed for this project.</td>
</tr>
</tbody>
</table>

5.1.2 Active As-Built

**Under Development**

5.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These tools include text tools, line and arrow tools, and stamp tools (all other tools will still be available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

![Figure 84 - As-Built Commenting Tools](image)

Issued 01-2015 90 Version 3.08
5.3 Applying As-Built Comments to Contract Plans

5.3.1 Before Using Bluebeam for As-Builds

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built revisions. By completing these steps as-built revisions will be standardized across all CTDOT users. These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

- Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
- Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
- The user must have a ProjectWise login/password. Contact Julie Annino if you do not have a Projectwise Username and Password.

5.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as shown below:

Figure 85 - Location of the Contract Plans in Projectwise
1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you are working on.
2. To open a document with Bluebeam right click on the document, and select “Open With” as shown below:

Right click on the plan subset to open and select "Open With"

3. Select the Bluebeam icon and check “Always use this program” and select OK. The document will now be checked out of Projectwise and open with Bluebeam:

Note: Since we checked “Always use this program”, the next time you open a pdf in ProjectWise all you need to do is double click on the file.
4. After the As-Builts are applied to the contract plans click save in Bluebeam and then select “Check In” when a projectwise dialog box pops up. If the document is not checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

5.3.3 Applying Digital As-Built Stamps

5.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet, located in the 01_General subset, as stated below:

1. Select the "ConstructionStartedandCompletedDates": stamp from the “CTDOT As Built Tools” tool box and place it at a conspicuous location on the title sheet:

   ![Figure 88 - Construction Started and Completed Date Stamp](image)
   
   **Figure 88 - Construction Started and Completed Date Stamp**

2. Enter Start and end and click OK as shown below:

   ![Figure 89 - Entering the Dates for the Stamp](image)
   
   **Figure 89 - Entering the Dates for the Stamp**
Below is an example of the placed stamp:

Figure 90 - Placed Stamp
5.3.3.2  This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to every sheet included in plan set, including the as-built revised sheets, and then go back and remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

![Figure 91 - Placing the "This Sheet Not Corrected Stamp"](image-url)
2. Right click on the stamp that was placed and select “Apply to All Pages”:

![Image of right-clicking and applying to all pages]

**Figure 92 - Placing the Stamp on All Pages**

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the pdf set.

**NOTE:** You must go back and replace this note on the sheets that contain as-built revisions with the appropriate stamp.
5.3.3.3 This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every sheet included in plan set, including sheets that do not contain as-built revisions, and then go back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

2. NOTE: You must go back and replace this note on the sheets that do not contain as-built revisions with the “THIS SHEET NOT CORRECTED” stamp.

5.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built tool box shown below and apply it to the document that is being as-built.

![As-Built Tools](image)

Figure 93 - As-Built Tools
In the following example, the Line tool was used to cross out the existing text and the Text Box tool was used to add text:

![Figure 94 - As-Built Note Example](image)

Additional tools are available by selecting Markup:

![Figure 95 - Other Markup Tools](image)

These tools include:

- **A. Text** – commonly used tool for as-builts
- **B. Typewriter** – Do Not Use for As-Builts – cannot edit text
- **C. Note** - Do Not Use for As-Builts – will not print
- **D. Flag**
- **E. Pen**
- **F. Highlight**
- **G. Eraser** - Do Not Use for As-Builts – cannot edit graphics
- **H. Line** – commonly used tool for as-builts
- **I. Arrow** – commonly used tool for as-builts
- **J. Arc**
- **K. Polyline**
- **L. Callout** – commonly used tool for as-builts
- **M. Dimension**
- **N. Box**
- **O. Circle**
P. Polygon

Q. Cloud – Do Not Use for As-Builts - this may be confused with change orders or addendums

R. Picture – Pictures can be inserted into a document or attached. It is recommended that pictures be attached as not to obstruct any part of the pdf.

Do not add a note to a comment by double clicking on the comment. For example, if a line was placed the user could double click on the line and add notes to it:

![Figure 96 - Incorrect Way to Add Text](image)

If notes are added this way they do not print.

5.3.4.1 Digital As-Built Stamps and Notes Using ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this folder: C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous sentence, if version 10 is used replace with 10.

**Stamp Files**
- As-Built stamps.pdf
- Construction started and completed dates.pdf

These stamps are to be placed following Section 5.3 above.

As-Built notes shall be placed on the plans in accordance with Section 5.3 using the Adobe commenting tools in the following format:

1. Text Font shall be Cambria 16, and the color Red.
2. All line work shall be line width 2 and the color Red.
5.4 Notifications

5.4.1 Notifying Department Personnel

After the as-built information has been completed and the above form has been sent to AEC Applications, the person responsible for the as-built revisions shall notify the appropriate Department personnel (via e-mail):

- Lead Designer
- Chief Inspector
- Central Surveys
- ROW
- Central Construction
- Bridge Maintenance (if a structure is on the project)
- Ronald Tellier – AEC Applications  Ronald.Tellier@ct.gov
Section 6 Contractor Submittals

Under Development

This section details how various contractor submittals shall be formatted, submitted, and reviewed by CTDOT.

The contractor submittals that are detailed in this section are as follows:

- Shop Drawings
- Working Drawings for Permanent Structures
- Working Drawings for Temporary Structures

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allows the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location. Projectwise also allows the Contractor to access the Department’s comments quickly after they review the submittal.

Important Note for the Designer

By the FDP date the designer is required to fill out columns A through G in the spreadsheet labeled “CNS Item List” located in the 240_Contract_Development Folder under the project in Projectwise for each item in the contract that requires a shop or working drawing submittal.

Items that have multiple sites or structures, such as sign supports, shall be split up by site or structure.

The spreadsheet shall be filled out in accordance with the following:

- **Label (User Defined)** – Item number. For multiple structures or sites add an “_01”, “_02”, etc, after the item number for each site.
- **Description** – Item Description
- **Sub Category** – Shop Drawing, WDP (Working Drawings for Permanent Structures), or WDT (Working Drawings for Temporary Structures). This is a drop down.
- **Bridge No(s)** – Type in the bridge number(s) the submittal is associated with.
- **Sign Structures** - Type in the sign structure number(s) the submittal is associated with.
- **Signals Intersections** - Type in the signal intersection number(s) the submittal is associated with.
- **Project Number** – The project number(s).

The first three rows in the spreadsheet are filled out as an example and should be edited when the designer fills out this spreadsheet. Once the designer fills out this spreadsheet they shall notify Mathew.Calkins@ct.gov and Henok.Abdissa@ct.gov of AEC applications. AEC applications will then create placeholder documents in Projectwise that the Contractor will edit for each Contractor Submittal. If this spreadsheet is not updated the placeholder documents will not be created and the Contractor will not be able to submit their Contractor Submittals.

Contractor Requirements

The Contractor is required to use the latest version of Bluebeam REVU to edit the Shop and Working Drawing submittals as well as digital sign any Working Drawing Submittals. See section 1.3 for the required prerequisites and policies for the following workflows.
6.1 Workflows

The following shows the workflow for the Shop Drawing submittal process:

**SHOP DRAWING WORKFLOW**

1. **Gain Access to CTDOT’s Projectwise Site,** See [section 1.3 step 13](#).

2. **Purchase Bluebeam and have it installed on your computer,** See [section 1.3 step 10](#).

3. **Prepare Shop Drawing Submittal,** See [Section 6.2](#).

4. **Add drawings to the submittal located in Projectwise,** See [Section 6.3.1](#).

5. **Submit the 2nd, 3rd, 4th, etc. submissions,** See [Section 6.3.2](#).

6. **Send an email notification to the District Construction and the Designer stating a shop drawing submittal is ready for their review,** See [Section 6.3.1 step 14](#) for the initial submittal and [Section 6.3.2 step 10](#) for subsequent submittals.

7. **Review the Shop Drawing submittal. Markup the plans as necessary and stamp each drawing:** Approved, Approved as Noted, or Revise and Resubmit. See [Section 6.4.1](#) for the initial submittal and [Section 6.4.2](#) for subsequent submittals.

8. **If all drawings are stamped Approved or Approved as Noted**
   - **Change the State of the document to CLOSED,** see [Section 6.4.1 step 14](#).
   - **Send an email notification to the Contractor stating the shop drawing submittal has been reviewed and include the status of each drawing,** whether it is Approved or Approved as Noted. See [Section 6.4.1 step 15](#).
   - **Print the required paper copies of the submittal and mail to the required people.**

9. **If any drawing is stamped Revise and Resubmit**
   - **Create a New Version of the submittal,** see [Section 6.4.1 step 11](#).
   - **Send an email notification to the Contractor stating the shop drawing submittal has been reviewed and include the status of each drawing,** whether it is Approved, Approved as Noted, or Revise and Resubmit. See [Section 6.4.1 step 15](#).
The following table shows the workflow for the Working Drawings for Permanent and Temporary Structures submittal process:

**WORKING DRAWINGS FOR PERMANENT AND TEMPORARY STRUCT. WORKFLOW**

<table>
<thead>
<tr>
<th>Contractor/Designer</th>
<th>Contractor</th>
<th>Designer</th>
<th>District Construction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain Access to CTDOT’s Projectwise Site, See section 1.3, step 13</td>
<td>Purchase Bluebeam and have it installed on your computer. See section 1.3, step 10.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Prepare Working Drawing documents, See Section 6.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Add document to the submittal located in Projectwise, See Section 6.3.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Submit the 2nd, 3rd, 4th, etc. submissions, Section 6.3.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send an email notification to the District Construction and the Designer stating a working drawing submittal is ready for their review, See Section 6.3.1 step 14 for the initial submittal and Section 6.3.2 step 10 for subsequent submittals</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Decision Point: Designer Review Required**

- **NO**
  - Change the State of the document to REVIEWING, see Section 6.4.1 step 14
  - Review the working drawing submittal. Markup the plans as necessary and stamp each drawing: Approved or Not Approved and update the submittal cover sheet with your response. See Section 6.4.1 for the initial submittal and Section 6.4.2 for subsequent submittals.
  - If all drawings/documents are Approved
    - Change the State of the document to CLOSED, see Section 6.4.1 step 14
    - Send an email notification to the Contractor stating the working drawing submittal has been reviewed and is Approved, See Section 6.4.1 step 15
    - Print the required paper copies of the submittal and mail to the required people.
  - If any drawing/documents are Not Approved
    - Create a New Version of the submittal, see Section 6.4.1 step 11
    - Send an email notification to the Contractor stating the Working drawing submittal has been reviewed stating the submittal is Not Acceptable. See Section 6.4.1 step 15

- **YES**
  - Change the State of the document to REVIEWING, see Section 6.4.1 step 14
  - Review the working drawing submittal. Update the submittal cover sheet with your response. For the initial submittal see Section 6.4.1 and for subsequent submittal see Section 6.4.2
6.2 Submittal Format Requirements

The following is a list of requirements for contractor submittals. For both Shop and Working Drawing submittals, CTDOT will create a document for all required submittals in Projectwise based on the “CNS Item List” that is submitted by the designer at FDP. If a submittal is not in Projectwise notify AEC Applications (Mathew.calkins@ct.gov and Henok.Abdissa@ct.gov) and the document will be created. The Contractor is required to edit these documents by adding the drawings/documents required for each submittal:

SHOP DRAWING SUBMITTALS

1. Drawings shall be sized ANSI D (34” x 22”) and each drawing shall be in a separate PDF file.
2. Each drawing shall have a border and title block. Located in the lower right hand corner of the drawing adjacent to the title block, each drawing shall have a rectangular box, 2 ¼” wide x 1 ¾” high, for the reviewers stamp.
3. On the ANSI D full scale sheets, the minimum text height and width shall be 1/8”.
4. All letter characters shall be uppercase.
5. Drawing shall be searchable.
6. Drawings shall be added to its associated item number package in Projectwise. The file name for the drawings shall be the drawing number when it is added to the package in Projectwise.
7. The documents in Projectwise contain a cover sheet for the submittal that must be filled out before notifying the CTDOT that a submission is ready for their review.
8. Drawings shall be added to the documents in Projectwise in accordance with Section 6.3.1
9. Drawings for the 2nd, 3rd, 4th, etc. submissions of a submittal shall be added in accordance with Section 6.3.2
WORKING DRAWING FOR PERMANENT STRUCTURE SUBMITTALS

1. Drawings shall be sized ANSI D (34” x 22”) and be in a single PDF document.
2. Each drawing shall have a border and title block. Located in the lower right hand corner of the drawing adjacent to the title block, each drawing shall have a rectangular box, 2¼” wide x 1 ¾” high, for the reviewers stamp.
3. On the ANSI D full scale sheets, the minimum text height and width shall be 1/8”.
4. All letter characters shall be uppercase.
5. Drawing shall be searchable.
6. Calculations shall be sized ANSI A (8.5” x 11”) and be in a single PDF document.
7. Catalog cuts shall be sized ANSI A (8.5” x 11”) and be in a single PDF document.
8. All drawings must contain a watermark of the engineer’s PE stamp place in a common area of the border. The watermark shall be placed in accordance with section 2.4.
9. All drawings shall be digitally signed using a CDS signature in accordance with section 2.
10. All calculations shall be digitally signed using a CDS signature in accordance with section 2.

11. All documents for a submittal shall be added to the associated package in Projectwise. Documents shall be named in accordance with the following before being added to the associated package in Projectwise:
   a. The file names for the initial drawings shall be “Drawings”.
   b. The file name for the calculations shall be “Calculations”.
   c. The file name for the catalog cuts shall be “Catalog Cuts”.
12. The documents in Projectwise contain a cover sheet that must be filled out before notifying the CTDOT that a submission is ready for their review.
13. Drawings shall be added to the documents in Projectwise in accordance with Section 6.3.1.
14. Drawings for the 2nd, 3rd, 4th, etc. submissions of a submittal shall be added in accordance with Section 6.3.2.
WORKING DRAWING FOR TEMPORARY STRUCTURE SUBMITTALS

1. Drawings shall be sized ANSI D (34” x 22”), ANSI B (17” x 11”), or ANSI A (8.5” x 11”) and be in a single PDF document. Engineering judgment should be used when determining which paper size to use and what size would be best for reviewing.

2. Each drawing shall have a border and title block. Located in the lower right hand corner of the drawing adjacent to the title block, each drawing shall have a rectangular box, 2 ¼” wide x 1 ¾” high, for the reviewers stamp.

3. Calculations shall be sized ANSI A (8.5” x 11”) and be in a single PDF document.

4. Catalog cuts shall be sized ANSI A (8.5” x 11”) and be in a single PDF document.

5. All scanned documents must have a minimum resolution of 200 dpi.

6. All drawings must contain a watermark of the engineer’s PE stamp place in a common area of the border. The watermark shall be placed in accordance with section 2.4

7. All drawings shall be digitally signed using a CDS signature in accordance with section 2

8. All calculations shall be digitally signed using a CDS signature in accordance with section 2

9. All documents for a submittal shall be added to the associated document in Projectwise. Documents shall be named in accordance with the following before being added to the associated document in Projectwise:
   a. The file names for the initial drawings shall be “Drawings”.
   b. The file name for the calculations shall be “Calculations”.
   c. The file name for the catalog cuts shall be “Catalog Cuts”.

10. The documents in Projectwise contain a cover sheet that must be filled out before notifying the CTDOT that a submission is ready for their review.

11. Drawings shall be added to the documents in Projectwise in accordance with Section 6.3.1

12. Drawings for the 2nd, 3rd, 4th, etc. submissions of a submittal shall be added in accordance with Section 6.3.2
6.3 Contractor – Adding Documents to the Contractor Submittals

6.3.1 Initial Submittal

The following shows the procedures and responsibilities of the Contractor when adding drawings/documents to the initial Shop or Working drawing submittal.

1. Prepare the drawings/documents for the submittal in accordance with Section 6.2 of this manual.

2. Next log into Projectwise by clicking on this link and entering your Projectwise Username and Password- https://ctdot.projectwiseonline.com

![Projectwise Log In Screen](image)

Figure 97 - Projectwise Log In Screen
3. Browse to the active construction projects located in the 01.0 – Projects Active area in Projectwise. Then browse out to your project and click on the 120_Contractor Submittal folder as shown below:

![Diagram showing browsing process]

_Figure 98 - Browsing out to a Folder_
4. Next open the file for the submittal you are working on as shown below:

![Opening a Document from Projectwise]

Right click on the file and select More then Open

Figure 99 - Opening a Document from Projectwise
5. When you open it you will be looking at the PDF Package. After the file opens double click on the submittal cover sheet shown below:

![PDF Package]

**Figure 100 - Filling out the submittal cover sheet**

6. Fill in the fields on the top portion of the form, as shown below for the initial submittal: The section below shows a shop drawing submittal but the procedure is the same for a working drawing submittal.

![Fill out the Contractor part of the form.]

**Figure 101 - Initial Shop Drawing Submittal**
7. After the fields are filled in, click save and close the cover sheet as shown below:

![Figure 102 - Saving the Form](image)

**SHOP DRAWINGS**

8. This step is for shop drawing submittals only. For working drawings see step 10. Next add the drawings for the submittal by clicking on the Add files icon and selecting the drawings to be added to the submittal. Then click Open as shown below:

![Figure 103 - Adding Drawings to a Shop Drawing Submittal](image)

9. Click save and close Bluebeam.
WORKING DRAWINGS

10. **This step is for working drawings submittals only.** Next add the drawings, calculation, and catalog cut files for the submittal by clicking on the Add files icon and selecting the applicable files.

![Figure 104 - Adding files to a Working Drawing Submittal](image)

- Click on the add files icon
- Select all the files and then click Open

Figure 104 - Adding files to a Working Drawing Submittal
11. Next go back to Projectwise and right click on the submittal in Projectwise and select Check In as shown below:

Figure 105 - Checking a Document In

12. After the submittal is uploaded to Projectwise, send an email notifying the designer and district construction. Below is an example of an email for a submittal.

Figure 106 - Email Example
6.3.2 Contractor – Subsequent Submittals (Revise and Resubmit)

The following shows the Contractor how to upload revise and resubmit contractor submittals. After being notified by the designer or district construction that the drawing(s)/document(s) have been stamped “Revise and Resubmit” or “Not Acceptable”, the Contractor will do the following depending on what type of submittal they are working on:

**Shop Drawings** – Delete the revise and resubmit sheet(s) and add the revised sheets into the submittal PDF Package.

**Working Drawings** – Delete the Not Acceptable files and replace with the new files.

The following shows how to submit the updated drawings/documents.

1. Log into Projectwise – [https://ctdot.projectwiseonline.com](https://ctdot.projectwiseonline.com)
2. Browse out to your project and go to the 120_Contractor_Submittal folder:

![Figure 107 - Browsing to the Project](image)

3. Next open the submittal as shown below:
Figure 108 - Opening a Document from Projectwise
4. After the submittal opens double click on the submittal cover sheet.

5. Next fill out the fields correct submittal column. Below is an example showing the second submission column:

6. After the fields are filled in, click save and close the form as shown below:
7. Next delete the existing files and add the revised drawings/documents to the submittal. To delete, right click on the file and select delete.

To add the revised drawings/documents click on the Add files icon and then select the revised drawings/documents and click Open as shown below: The figure below shows a shop drawing submittal but the same procedure is used for adding the revised drawings, calculations, or catalog cuts to a working drawing submittal.

8. Then click save and close Bluebeam.
9. Next go back to Projectwise and right click on the submittal in Projectwise and select Check In as shown below:

Figure 113 - Checking a Document In

10. After the revised shop drawing(s) or working drawings are submitted, send an email notifying the designer and district construction that the revised drawings/documents have been uploaded into Projectwise and is available for review. Below is an example of an email for a shop drawing submittal:

Figure 114 - Email to CTDOT
6.4 CTDOT/Consultant – Contractor Submittal Review

CTDOT/Consultant shall review the contractor submittals using Bluebeam to apply any markups and the Submittal Review stamp to each drawing/document in the submittal. Before starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile contains all the markup tools as well as the submittal stamp that needs to be applied to all contractor submittals.

**CTDOT Newington Employees** – The profile is located on the X:// Drive in the V8 Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT Bluebeam User.

**CTDOT District Construction Employees** – Save this file to your desktop and then double click on it Bluebeam Profile.

**Outside Consultants/Designers** – A custom stamp must be created that includes your company’s information. See Appendix D of this manual.

In each submittal there will be a submittal cover sheet that tracks all the information for the submittal. The CTDOT/Consultant shall record all their responses or comments for the submittals on this cover sheet, whether the drawings/documents are stamped Approved, Approved as Noted, or Revise and Resubmit for shop drawings, or Accepted or Not Accepted for Working Drawings. The form shall be updated throughout the review process for all submissions associated to a Contractor Submittal.

For working drawing submittals that are reviewed by the engineer, the drawings and calculations need to be stamped by both the engineer and district construction and the submittal cover sheet will need to be filled out by the engineer and district construction.
6.4.1 Initial Contractor Submittal Review

CTDOT or Consultant Review

The following shows how to review an initial contractor submittal. The figures show a shop drawing submittal but the procedures are the same for a shop or working drawings submittal.

1. Log into Projectwise.
2. Browse out in the 01.0 – Projects – Active folder to the project’s 120_Contractor Submittal folder.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next.

Figure 115 - Changing the State of the Submittal
4. Then double click on the contractor submittal file to open:

Figure 116 - Opening a file from Projectwise
5. When the submittal opens, you should see the submittal cover sheet followed by the shop drawings or working drawings, calculation and catalog cuts as shown below: The following shows a shop drawing submittal but the procedure is the same for a working drawing submittal.

![Figure 117 - Example of a Submittal](image1)

6. Review the drawings/document by double clicking on one of the files and it will open in a new tab as shown below. Markup the drawings/document with comments using the markup tools located in the tool chest shown below. Also place the submittal review stamp that is also located in the tool chest.

![Figure 118 – Shop/Working Drawing Review Tools](image2)
**Submittal Review Stamp**

7. For CTDOT Engineers and district construction the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

To place the stamp, click on the stamp in the tool chest and then place it. Then select the appropriate option from the java script window. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

![Submittal Review Stamp](image1.png)

*Figure 119 - Submittal Review Stamp*

The stamp is now resized as shown below:

![Resized Stamp](image2.png)

*Figure 120 - Resized Stamp*

**NOTE:**
For drawings in a working drawing submittal there is a way to stamp all the drawings at once. Place the stamp on the first sheet and then right click on the stamp and select apply to all pages.
8. After the review is completed, close the file and click yes to save.

9. Repeat the review process for each drawing/document in the submittal.
10. After all or each one of the drawings/documents in the contractor submittal is reviewed the submittal cover sheet needs to be updated. To update this sheet double click to open and then fill in the appropriate information. See below:

Figure 122 - Shop Drawing Submittal Form

For working drawing submittals that are reviewed by the engineer, the drawings and calculations will be stamped only by district construction and the submittal cover sheet will need to be filled out by both the engineer and district construction.
11. After filling in the fields close Bluebeam and save. Then check the document back into Projectwise, by clicking on Check In in the Check In dialog box:

![Check In Dialog](image)

Figure 123 - Check In Dialog

12. If all the drawings/documents are Approved or Approved as Noted, proceed to step 14. If any of the drawings need to be revised and resubmitted, proceed to step 11.
Drawing Stamped Revise and Resubmit

13. If any of the drawings need to be revised and resubmitted:
   a. Shop Drawings - The engineer will created a new version of the submittal to keep as a record of that submittal.
   b. Working Drawings – District Construction will created a new version of the submittal to keep as a record of that submittal.

To create a new version right click on the submission in Projectwise and select New>Version:

Figure 124 - Creating a New Version
14. Next type in the version as shown below. The example below is for a second submission:

![New Document Version window]

**Figure 125 - Creating a New Version**

15. After you create the version you will see it underneath the new version. The Contractor will only be able to see the current version, so they can’t update the wrong file. CTDOT and Consultants will be able to view all versions for document comparison.

![Version Column]

**Figure 126 - Version Column**
16. **Only for submittals where all drawings/documents are stamped Approved or Approved as Noted:** Once all the drawings/documents are Approved or Approved as Noted, the state of the submittal must be changed to CLOSED. To change the state follow the figure below:

![Figure 127 – Changing the State of a Document](image)

Right Click on the submittal and select Change State>Next

![Figure 128 - Changing the State](image)

Click OK you do not need to enter a comment
17. Next send an email notification to the Contractor after all the shop or working drawings have been reviewed. Include a table in the email detailing your comments. Below is an example of a response for a shop drawing submittal with a revise and resubmit required:

![Email Response to a Shop Drawing Submittal](image)

**Figure 129 - Email Response to a Shop Drawing Submittal**
6.4.2 Subsequent Contractor Submittal Reviews

CTDOT or Consultant Review
After notifying the Contractor through email that all the drawings/documents have been reviewed they will revise and resubmit any drawings/documents that were stamped as such. Once they contact you via email that the revised drawings/documents have been uploaded, the drawings/documents can be reviewed in accordance with the following:

1. Log into Projectwise
2. Browse out to the project’s 120_Contractor Submittal folder.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next.

![Figure 130 - Changing the State of the Submittal]
4. Then double click on the submittal file to open. Note: The initial submittal will be updated to include any revise and resubmitted drawings/documents, a second file will not be submitted:

**Figure 131 - Opening a file from Projectwise**
5. When the file opens double click on the submittal cover sheet. Also if you open the submittal cover sheet the Contractor will have updated the submission information, as shown below:

**Figure 132 - Revised Shop Drawings**

<table>
<thead>
<tr>
<th>ITEM NO.</th>
<th>SITE NO(s): 1 and 2</th>
<th>BRIDGE NO(s): 01564.01457</th>
</tr>
</thead>
</table>

- **DATE:** 9/25/13
- **NOTES:** Resubmitting drawing GN-1 to resolve CTDOT’s comments
- **TOTAL PAGES:** 1

**Contractor will fill in this information**

**Figure 133 - Revised Shop Drawings**

6. Open up the revised drawings/documents, review, apply comments if necessary, apply stamp and save the file.

7. After the file is reviewed record the resolution for the drawing/document under the applicable submission as shown below:

**Figure 134 - Revised Shop Drawings**

8. After the information is filled out, close the form and save. Then close Bluebeam and select “Check in” to Projectwise.

9. If any of the drawings/documents need to be revised and resubmitted, create a new version as shown in Section 6.4.1 step 13. If all the drawings/documents are Approved or Approved as Noted, proceed to the next step.
10. **Only for submittals where all drawings/documents are stamped Approved or Approved as Noted:** Once all the drawings/documents are stamped Approved or Approved as Noted, the state of the PDF Package must be changed to CLOSED. To change the state follow the figure below:

Right Click on the submittal and select Change State>Next

**Figure 135 - Changing the State of a Document**

Click OK you do not need to enter a comment

**Figure 136 - Changing the State of a Document**
11. Once review is completed send an email notification to the Contractor. Include a table in the email detailing your comments. Below is an example of a response for a shop drawing submittal:

<table>
<thead>
<tr>
<th>Drawing No.</th>
<th>Status</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>G-1</td>
<td>Approved</td>
<td></td>
</tr>
<tr>
<td>H-1</td>
<td>Approved as noted</td>
<td>The dimensions for the bearing pad have been updated.</td>
</tr>
<tr>
<td>J-1</td>
<td>Approved</td>
<td></td>
</tr>
<tr>
<td>K-1</td>
<td>Approved as Noted</td>
<td>The material has been updated to A50.</td>
</tr>
<tr>
<td>M-1</td>
<td>Approved</td>
<td></td>
</tr>
</tbody>
</table>

Mathew Calkins, P.E.
Transportation Engineer 3
AEC Applications
Connecticut Department of Transportation
2859 Berlin Turnpike
P.O. Box 317546
Newington, CT 06111-7546
860-594-2988
Mathew.calkins@ct.gov

Figure 137 - Email Response to Shop Drawing Submittal
7.1 Introduction

**What is a Digital Review?**

A digital review is when a document is reviewed in its native digital format or as a digital copy of the original paper document, and any required markups are placed directly on the document using a computer and software designed for managing digital reviews. The documents can always be printed from the review session and the paper copy marked up, but those mark ups must get transferred back to the digital copy.

**Advantages of a Digital Review Compared to Conventional Paper Review**

2. Digital markups are searchable and sortable, by comment, author, etc.
3. Real time collaboration review process improves turnaround time and quality.
4. Real time feedback allows easier handling of large amounts of data.
5. Reduction in time required to compile and resolve comments.
7. Eliminate shipping cost.
8. Easily store a permanent digital record on the cloud.
9. Reduction in overall review time.

**Types of Reviews:**

This manual may be used as a guide to perform a digital document review on any digital document. Below is a list of examples:

- Preliminary Design Plans
- Structure Type Studies
- Semi-Final Plans
- Final Plans for Review
- Specifications
- Engineering Reports

**Review Process:**

To help participants of a digital review more easily track the digital review process it has been split up into six Phases as described below:

- Phase 1 – Preparation of the Digital Documents
- Phase 2 – Set Up Digital Review
- Phase 3 – Invite Attendees to Review
- Phase 4 – Digital Review
- Phase 5 – Ending the Digital Review
- Phase 6 – Resolve Comments

Each phase and its required steps will be discussed later in detail.

**Digital Comments:**

Digital documents may be printed to paper copies to facilitate the digital review process. Reviewers will have the ability to print the digital review documents to paper and mark them up, however, in the end all comments must be transferred from paper to the digital documents, during the review session, see Section 7.7.3.
In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

Comments associated with a design submission should be applied to the digital documents. Any email or phone call comments must be applied, by the staff member who received them, to the correct digital document, use engineering judgment to determine the most appropriate location.

All comments must be placed on the digital documents prior to the end of the session. The district may review on paper but those comments need to be transferred into the digital review session in accordance with this manual.

The following video gives an overview of the Digital Review Process. Specific details are found in this document.

Digital Review Video

7.2 Prerequisites

1. CTDOT is standardizing its digital review process using the document format PDF, and the software Bluebeam Revu. Bluebeam Revu was chosen for the following main reasons:
   a. Includes a collaborative live review feature (STUDIO) with real time feedback, enabling all reviewers to comment on the same document at the same time out on the cloud.
   b. Revu is cost affective, it is much less expensive to purchase and maintain vs. competitive software like Adobe Acrobat.
   c. Only the Organizer (person setting up the review) is required to have a licensed copy of Bluebeam. All other attendees can participate in the digital review using Bluebeam’s free software, Bluebeam VU.
   d. Bluebeam is integrated with ProjectWise. This simplifies delivering of the original review documents and saving the final reviewed copies and their comments.
   e. Easy to use without sacrificing technology.

2. The following table lists the software required in order to organize or participate in a CTDOT digital review.
   Note: The roles stated below are further defined in Section 7.3

<table>
<thead>
<tr>
<th>Role</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizer – Manages review</td>
<td>Bluebeam Revu Standard Latest Available Version</td>
</tr>
<tr>
<td></td>
<td>Projectwise Explorer Latest Available Version</td>
</tr>
<tr>
<td>Author – Produces documents</td>
<td>Projectwise Explorer Latest Available Version</td>
</tr>
<tr>
<td>Reviewer – Reviews documents</td>
<td>Bluebeam Revu Standard or Bluebeam VU latest available version*</td>
</tr>
<tr>
<td>Approver – Reviews</td>
<td>Bluebeam Revu Standard or Bluebeam VU latest available version*</td>
</tr>
</tbody>
</table>

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT organizing a review). When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the invitation. Note: An IT administrator may have to install this software on your computer.

3. All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.
7.3 Digital Review Workflow

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.

Below is the workflow for a typical Digital Design Review.

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Phase 1 – Preparation and Delivery of the Digital Documents</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>Organizer</td>
<td>Coordinates the organization and preparation of the review documents. Request all Authors to upload their review documents into Projectwise.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td>1.2</td>
<td>Author</td>
<td>Prepare and upload review documents into Projectwise. Then notify Organizer this step has been completed.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td>1.3</td>
<td>Organizer</td>
<td>Check that all review documents have been prepared and uploaded correctly into Projectwise.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td></td>
<td><strong>Phase 2 – Set up Digital Review</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>Organizer</td>
<td>Change the state of the review documents in Projectwise to “Review”. Starts a Bluebeam review session.</td>
<td>Section 7.5</td>
</tr>
<tr>
<td></td>
<td><strong>Phase 3 – Invitation to Review</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td>Organizer</td>
<td>Create a Digital Review memo, which includes a link the digital review session, and send it to all Reviewers. Also send paper to District Construction.</td>
<td>Section 7.6</td>
</tr>
<tr>
<td></td>
<td><strong>Phase 4 – Digital Review</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1</td>
<td>Reviewer</td>
<td>Join the review session by clicking on the link provided in the review memo. Familiarize yourself with the review session layout.</td>
<td>Section 7.7.1 and Section 7.7.2</td>
</tr>
<tr>
<td>4.2</td>
<td>Reviewer</td>
<td>Set Status to “Reviewing”</td>
<td>Section 7.7.2</td>
</tr>
<tr>
<td>4.3</td>
<td>Reviewer</td>
<td>Review the documents in the Bluebeam review session and place comments on documents as necessary.</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.4</td>
<td>Reviewer</td>
<td>When finished reviewing, Set Status to “Finished” Optional: Notify supervisor (Approver) to review your comments. If supervisor approval is not needed, skip to Step 4.9</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.5</td>
<td>Approver</td>
<td>Join session by clicking on the link in the review memo. Familiarize yourself with the format of the Bluebeam review session layout.</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.6</td>
<td>Approver</td>
<td>Set status to “Reviewing”</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.7</td>
<td>Approver</td>
<td>Review your subordinate’s comments. If you would like to review the documents yourself, mark up the documents with comments. (Step 4.1 – 4.3)</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.8</td>
<td>Approver</td>
<td>Set Status to “Finished” and notify Reviewer that you have</td>
<td>Section 7.7.3</td>
</tr>
</tbody>
</table>
4.9 Reviewer Create a comment report memo for each document in the review session. Then send the memo for each document to that document’s author. Section 7.7.3.1

Phase 5 – Closing the Digital Review

5.1 Organizer Close the Bluebeam review session and check the documents back into Projectwise. Section 7.8

5.2 Organizer Change the State of the documents to “REVIEW RESOLUTIONS” Section 7.8, Step 5

Phase 6 – Resolve Comments

6.1 Organizer Notify Authors that they can review the markups on their review documents in Projectwise. Provide them with a link to the folder in Projectwise. Section 7.9.1

6.2 Author Open your document(s) from Projectwise. Section 7.9.2

6.3 Author For each comment on your document, type a final resolution. Section 7.9.2

6.4 Author After all resolutions are applied to comments, create a response to comment memo for your review document(s). Send the response to comments memo to all applicable personnel. Section 7.9.2

6.5 Organizer Create a “Response to Review Comment Memo” and send to all necessary staff. This memo shall include a link to the folder in Projectwise where the review documents are located. Section 7.9.2, step 8.

6.6 Organizer Change the state of all the review documents to “Review Complete” to make all review documents read only. Section 7.10

7.4 Phase 1 – Digital Document Preparation

7.4.1 Organization

The Organizer shall organize the review documents as detailed below:

Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Plans - Shall be in discipline subsets. The Organizer is responsible for assigning each Author a subset number in accordance with Section 1.10 or Section 1.11

2. Specifications – Each discipline shall combine all of their specifications into (1) PDF document. Each discipline’s specifications will remain separate throughout the review session; they will not be combined with the other discipline’s specs.

3. Other Documents – Shall be individual PDF documents.

4. Plans must be sent to District Construction, but any comments they make on the paper plans must be transferred to the digital plans in accordance with this manual.

Other Reviews

1. The only requirement for the organization of other types of reviews is the documents must be in PDF format.

7.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following:

Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Plans:
   a. Shall be in PDF format
   b. In discipline subsets
   c. Sized 34” x 22”
   d. Shall not have watermarks, sheet numbers or be digitally signed.

2. Specifications:
   a. Each discipline shall combine all of their specifications for review in (1) PDF document.
b. Sized 8.5” x 11”

3. Other Documents:
   a. Shall be in PDF Format

Other Reviews

1. Documents:
   a. Shall be in PDF Format

7.4.3 Uploading

Authors shall upload their digital documents into Projectwise in accordance with the following:

Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Launch Projectwise and log in.
2. Browse out to the project this review is for and open up the 310_Review_Documents folder:

![Projectwise Explorer](image)

Browse out to the applicable project and click on the this folder

Figure 139 - Projectwise Project
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

![Figure 140 - Uploading Documents into Projectwise](image)

4. Select Advanced Wizard

![Figure 141 - Advanced Wizard](image)
5. Click next until you get to the attributes screen shown below and enter the correct attributes from table below, and then click next until the document uploads.

![Image of attributes screen]

Figure 142 - Attributing a Document

The Label attribute shown below must start out with 30%, 60%, 90%, or 100% where applicable. This allows for the documents to be sorted together in Projectwise. See Figure 147 for an example.

<table>
<thead>
<tr>
<th>Document</th>
<th>Disc.</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline Subsets</td>
<td>CT</td>
<td>CON</td>
<td>PRE</td>
<td>30% - 01-General, 30% - 03-Highways, etc. 60% - 01-General, 60% - 03-Highways, etc. 90% - 01-General, 90% - 03-Highways, etc</td>
<td>01-General Semi Final Plans…</td>
</tr>
<tr>
<td>Specification</td>
<td>CT</td>
<td>CON</td>
<td>PRE</td>
<td>30% - HWY- Specs, 30% - SB-Specs 60% - HWY- Specs, 60% - SB-Specs</td>
<td>Highway Semi Final Specs,</td>
</tr>
<tr>
<td>PD Statement</td>
<td>CT</td>
<td>DOC</td>
<td>MDO</td>
<td>30% - PD Statement</td>
<td>Preliminary Design Statement</td>
</tr>
<tr>
<td>Cost Estimate</td>
<td>CT</td>
<td>DAT</td>
<td>EST</td>
<td>90% - Cost</td>
<td>PD Cost Estimate</td>
</tr>
<tr>
<td>Bike Assessment</td>
<td>CT</td>
<td>DOC</td>
<td>MDO</td>
<td>30% - Bike Assessment</td>
<td>i.e. PD Bike Assessment</td>
</tr>
<tr>
<td>Calendar Day Est.</td>
<td>CT</td>
<td>DAT</td>
<td>EST</td>
<td>90% - Calendar Day</td>
<td>i.e. SF Calendar Day Estimate</td>
</tr>
</tbody>
</table>

Table 2 - Projectwise Document Attributes

**Other Reviews**

1. Launch Projectwise and log in.
2. Browse out to the folder where the digital documents are to be stored.
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

![Uploading Documents into Projectwise](image1)

Figure 143 - Uploading Documents into Projectwise

4. Select Advanced Wizard

![Advanced Wizard](image2)

Figure 144 - Advanced Wizard
5. Click Next until you get to the attributes screen shown below and enter the correct attributes for the review documents and then click next until the document uploads. Make sure a good label and description are entered.

Figure 145 - Uploading Documents

6. Notify the Organizer that you have uploaded all your documents into Projectwise.
7.5 Phase 2 – Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: The example below is for initiating a Semi-Final review but can also be followed for other types of reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.
2. Browse out to your project’s 310_Review_Documents folder. (For other reviews browse out to the folder in Projectwise where the documents are located.)

3. Select all the documents to be included in the Bluebeam review session.

Figure 146 - Preliminary Design Documents Folder

Figure 147 - Select Documents to be Included in Bluebeam Review Session
4. Change the state of the documents to “Review” as shown below:

Figure 148 - Changing the State to Review

Then click OK next on the box that pops up. The documents will now be in the Review state.

Figure 149 - State of Documents
5. Next right click on the documents and select "Start Studio Session".

Right Click on the documents and select "Start Studio Session"

Figure 150 - Start Studio Session
6. In the figure below type in a review session name shown in the table below:

<table>
<thead>
<tr>
<th>Review</th>
<th>Review Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary Design (30%)</td>
<td>Project XXXX-XXXX PD Review</td>
</tr>
<tr>
<td>Structure Type Study</td>
<td>Project XXXX-XXXX Structure Type Study Review</td>
</tr>
<tr>
<td>Semi-Final (60%)</td>
<td>Project XXXX-XXXX SF Review</td>
</tr>
<tr>
<td>Final Plans for Review</td>
<td>Project XXXX-XXXX FPFR Review</td>
</tr>
<tr>
<td>Other</td>
<td>Include Project number if necessary and give a good description of the review</td>
</tr>
</tbody>
</table>

Also in the figure below make sure all the options are checked as shown:

Figure 151 – Initiating a Review Session
7. The next dialog box is where you specify where the review session invitation is sent. The invitation will be an email from Bluebeam that includes a link to the review session. Since we want to invite reviewers using a memo, the invitation will only be sent to the Organizer so they can copy the review session link and include it in the memo.

In the dialog box below enter your email address so the link to the review session is emailed to you so you can include it in the review memo. (See Section 7.6- Phase 3 Invitation to Review Session for information on how to include this link in the review memorandum)

![Adding Email Address to Studio Session](image)

*Figure 152 - Adding Email Address to Studio Session*
8. Below is an example of the review session email sent from Bluebeam to the organizer. The link to the session is circled below and can be copied and pasted into a review memo which is then forwarded to all necessary staff. If the review was set up for a less formal review, the email from Bluebeam containing the link can be forwarded to reviewers or the link copied and pasted into an email.

![Figure 153 - Studio Session Email](image)
7.6 Phase 3 – Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

The invitation to the digital review will be a PDF of a review memorandum that includes:

1. A table of all documents in the review session along with those documents authors.
2. Links to relevant documents that are not included in the review session but still need to be referenced. These documents shall be located in Projectwise and Projectwise links shall be included. (Not shown in the example below)
3. A link to this manual (Digital Project Development Manual)
4. A link to the Review session.

The PDF of the review memorandum shall be emailed to all Reviewers. Paper plans must be sent to District Construction for their review. Any comments they make must be transferred to the digital plans in accordance with this manual. The memorandum for a preliminary design review of contract document can be some variation of the following but must the things shown below:

![Sample Review Memo](image)

**Figure 154 - Sample Review Memo**

**Other Reviews**

Invitations for less formal reviews may not require a memo. We recommend an email be sent that includes the links to this manual and the review session.
7.7 Phase 4 – Digital Review

7.7.1 Joining a Review Session

To join a review session, click on the link provided in the review memorandum for preliminary design reviews, or the email for less formal reviews. Below is an example of a preliminary design review (semi-final), the link to the review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.
2. Click on the link to the Review Session.
3. Click Allow on the box that pops up in Internet Explorer.

![Internet Explorer Allow Screen]

Figure 157 - Accessing the Review Session

4. Bluebeam will launch. If this is your first time into a review session, create a Studio account. Enter in your state email address and a password. In the name type in your First Initial then Last name and unit. See below for an example.

![Studio Session Account]

Figure 158 - Studio Session Account
If this is not your first time in a review session, enter your studio log in information as shown below:

![Image of login screen]

**Figure 159 - Review Session**

5. If this is your first time into a review session you must import the CTDOT Bluebeam Profile, See Appendix A
7.7.2 Review Session Layout

When you enter a Bluebeam review session you will see the tab below located on the right hand side of the screen. This tab displays the attendees of the session, a list of documents in the session, and a record of all actions that take place in the session. On the bottom of the screen you will see the list of all comments placed on a document. If this bottom tab is not open, click on the blue half circle with the white dot in the middle. On the left of the screen you will find the commenting tools. The commenting tools in the list must be used because they have been set up for CTDOT use. Bluebeam’s default commenting tools will not be set up for CTDOT use.

All comments that are made get saved instantly to the Bluebeam review session; you do not need to manually save any comments. You can only delete comments you have made. You can leave and rejoin sessions as many times as you want as long as the review session has not been closed. The review session will be closed by the organizer in accordance with the date on the review memo.
7.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital review. Reviewers may print digital review documents to paper and mark them up; however, they must transfer these comments onto the digital review documents in accordance with this section.

In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

Comments associated with a design submission should be applied to the digital documents. Any email or phone call comments must be applied, by the staff member who received them, to the correct digital document. Use engineering judgment to determine the most appropriate location for all comments.

All comments must be placed on the digital documents during the review session.

Reviewer

1. First set your review status to Reviewing by clicking on the drop down shown below:

   Note: If you leave the session and return your status will stay as Reviewing.

   ![Set Status to Reviewing](image)

   Figure 161 - Set Status to Reviewing
2. Next select a document to review from the studio session tab.

![Select a document to comment on](Figure 162 - Selecting a Document to Comment On)

3. Select a commenting tool from the tool chest and mark up the plans. Below are the commenting tools a CTDOT user will have available to them in Bluebeam.

![Bluebeam Commenting Tools](Figure 163 - Bluebeam Commenting Tools)
MUST READ BEFORE PLACING COMMENTS

Comment tools: Text Box, Callout, and Flag are considered text tools but a text note can be added to any of the other comment tools by double clicking on the markup after you place it. The following figures show the correct way and incorrect way to add text to a non-text comment tool. The text note box must be closed after the comment is made by clicking on the X in the top right corner of the note. The example below shows a note being attached to the rectangle tool the correct way:

Correct Way

![Correct Way to Add Text to a Non Text Commenting Tool](image)

Incorrect Way

The example below shows the incorrect way to add text to a non-text commenting tool. This was incorrect because instead of double clicking on the rectangle and adding a note like the previous figure, they used the callout tool to add text. This results in two comments showing up in the comment list instead of one. Later in the digital review process, comments are reviewed and comment reports are created and these extra comments will make those two processes harder to do.

![Wrong Way to Add Text to a Non Text Commenting Tool](image)
4. After your review of the documents is completed set your status to *Finished*.

Note: You can still enter the session if your status is set to Finished. This status is for the Organizer so they know which Reviewers have completed their reviews.

![Figure 166 - Set Review Status](image1)

5. (Optional) Notify and send your supervisor (Approver) the review memo or link to the review session so they can review your comments. If supervisor approval is not needed, skip to step 13.

**Comment Reviewer – Supervisor Approvals**

If a supervisor makes comments themselves while they are approving their subordinate’s comments, they shall also approve their own comments in accordance with this section. The supervisor shall follow steps 1 through 5 of this section for commenting.

6. Join the review session by clicking on the link in the memo.
7. First set your status to *Reviewing* by clicking on the drop down shown below:

Note: If you leave the session and return your status will stay as Reviewing.

![Figure 167 - Set Status to Reviewing](image2)
8. Filter the markups so you only see your subordinates comments by clicking on the name of your subordinate and click filter markups as shown below:

![Image of filtering markups]

**Figure 168 - Filtering Markups**

Now on the document and in the list of comments it only shows the comments made by your subordinate.

![Image of filtered comment list]

**Figure 169 - Filtered Comment List**
9. For every comment you must type in a reply. This is done by right clicking on the comment and selecting *Reply* as shown below:

![Figure 170 - Replying to a Comment]

10. Then, at a minimum, type in *Agree* or *Delete* when replying. You can also reply with more detail using *Agreed As Noted*. See below for an example:

![Figure 171 - Supervisor Reply]
11. After you have finished replying to all of your subordinate’s comments, set your status to *Finished* as shown below:

![Set Status]

**Figure 172 - Set Review Status**

12. Notify your subordinate that you have reviewed all their comments and that all comments that you have marked with *Delete* will need to be deleted from the review documents.

### 7.7.3.1 Reviewer – Review Comment Memo

Each reviewer shall create a review comment memo with their comments attached. To do this a comment report from Bluebeam shall be created and copied into the comment memo.

13. Delete all comments from the review documents that your supervisor has instructed you to.

14. Create a review comment report of your comments. First filter out the comments so only your comments are displayed as shown below:

![Filtering Comments]

**Figure 173 - Filtering Comments**
15. Now that the comments are filtered by your name create a comment report as shown below:

![Image of Bluebeam interface with comment report settings]

Figure 174 - Creating a Comment Report

Next type in a title for the comment report that includes Project No, What review it is plus the word “Comments”, and what document this comment report is for. See below for an example:

**Project ####-#### Semi Final Review Comments 03-Highways**

Make sure all the settings are set as shown below and click OK:

![Image of Bluebeam interface with comment report settings]

Figure 175 - Comment Report Settings

16. The comment report will now be created and opened in Bluebeam, leave the comment report opened in Bluebeam. We will be copying this report into the comment report memo.

17. Save the following comment report memo to your computer or to the project on the X: drive: **Review Comment Memo**

18. Open the Review Comment memo and fill in all the correct information.
19. Copy the comment report pages into the comment report memo as shown below:
20. Paste the comment report into the Review Comment Memo as shown below:

![Image of the review comment memo process]

(1) Select the comment report memo document
(2) Select the thumbnail view
(3) Right click below the thumbnail of the memo and select paste pages

**Figure 177 - Pasting the Comment Report into the Comment Report Memo**

21. Save the memo and process this memo as your unit requires and forward to the review organizer.

22. Your role in the review session is now complete.
The Organizer will be responsible for closing the review. The review session will be closed per the date on the review memorandum.

1. Click Finish to close a Bluebeam Review Session as shown below:

![Click Finish](image-url)
2. Make sure all the reviewers in the list below are selected (they will be by default) and the “Save (Overwrite Existing)” button is checked and click OK.

![Figure 179 - Terminating a Session](image)

**Figure 179 - Terminating a Session**

3. Click Yes in the figure below.

![Figure 180 - Overwriting Existing Documents](image)

**Figure 180 - Overwriting Existing Documents**

4. Close Bluebeam Revu and check in each document to Projectwise. Note a check in box will pop up for each document in the review session.

![Figure 181 - Checking a Document Into Projectwise](image)

**Figure 181 - Checking a Document Into Projectwise**
5. Change the state of all documents in Projectwise to “REVIEW RESOLUTIONS” so the author of the documents can respond to all the reviewers’ comments. To do this select all documents, right click, select Change state, and click next.

7.9 Phase 6 – Resolve Comments

This section shows how the comments from the review session will be resolved by the Document Authors. After the comments are resolved in the PDF document a Response to the Review Comments memo will be sent out by the document author to all the reviewers.

7.9.1 Notify Authors

The Organizer shall notify the Authors by email that the digital review session has ended and the comments on the review documents can be resolved. This email shall include a link to the documents.

7.9.2 Resolving Comments

All comments on the review documents shall be resolved by the Author directly on the digital PDF review documents using Bluebeam. The following shows the steps for resolving comments and creating the resolution memo.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

![Figure 182 - Comment Resolutions](image)
3. In the box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.

**Resolution – Type in resolution...No Change to Plans**

Below is an example of a resolution being typed:

The resolutions applied to the plans shall be the final resolution decided by the Authors unit. If a TE2 writes a resolution on the plans and then the TE 3 reviews that resolution and it needs to be changed, the TE2 shall revise the resolution. There shall only be one resolution for each comment.

Below is an example of how the resolutions will look in the comment list.
4. Next create a comment report of all comments for the response to review comments memo. In the comment list, click on the “Author” header to sort the comments by Author as shown below: If the comment list is not sorted by Author before creating a comment report, the comments in the comment report will be difficult to follow.

Figure 185 - Sorting Comments by Author

5. Next select the following:

Figure 186 - Creating a Comment Report
6. Next type in a title for the resolution comment report that includes Project No, What review it is plus , “Comment Responses”, and what document this comment report is for. See below for an example:

   **Project ####-#### Semi Final Comment Responses 03-Highways**

![PDF Summary](image)

   - Make sure these settings are selected and type in the correct title
   - Click OK

   **Figure 187 - Creating Comment Report**

7. The comment report will now be created and opened in Bluebeam, leave the comment report opened in Bluebeam. We will be copying the pages of this report into the memo.

8. Save the following comment report memo to your computer or the project on the X: drive: **Response to Review Comment Memo**

9. Open the memo and fill in all the correct information.
10. Copy the response to review comment report pages into the memo as shown below:

Figure 188 - Copying the Comment Report into the Comment Report Memo
11. Paste the comment report into the Memo as shown below:

Figure 189 - Pasting the Comment Report into the Comment Report Memo

12. Save the memo and process this memo as your unit requires and forward to all reviewers.
7.10 Locking the Review Documents after the Review

The Organizer shall make all the review documents read only after the review process is over. This shall be done after the response to comment memos have been received. To lock the review documents, change the state of the documents in Projectwise to “Review Completed” as shown below:

1. Select all documents and change the state of the documents to “Review Completed” as shown below:

   ![Figure 190 - Changing the State to Review](image)

   The documents will now be read only to everyone, including the Projects lead design unit.

   ![Figure 191 - Review Complete State](image)
Section 8  CTDOT Project Location – Under Development

This section details the required information/documents that need to be submitted to CTDOT to locate all of our projects on a GIS (Geographic Information System).

The lead designer shall be responsible for providing the information/documents detailed in the following tables when filling out or updating the Project Asset Form located on the Projectwise Project Information Webpage at the following link:

Projectwise Composite Data

This information/document needs to be submitted or updated at the following project milestones:
- RPM
- Design Approval
- Final Design

The following tables detail what needs to be provided on the Project Asset Form for various project types. If your project type is not listed, contact AEC applications for guidance: Mathew.calkins@ct.gov or John.Rinaldi@ct.gov

<table>
<thead>
<tr>
<th>Project Milestone - RPM</th>
<th>Project Type</th>
<th>Required Information/Document</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Highway</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Paving</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Guide Rail, Barrier, Safety</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Improvements</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All other highway projects</td>
<td>Google Earth KML</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bridge Preservation projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Maintenance projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Retaining Wall Projects</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Sign Support Projects</td>
<td>List of sign supports in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Traffic</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Traffic Signals</td>
<td>List of traffic signals in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Rumble Strip</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Facilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Facility or Rehab of Existing Facility</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Rail Project</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>District Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>State wide Projects</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Project Milestone – Design Approval

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Required Information/Document</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highway</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paving</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>All other highway projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Bridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Retaining Wall Projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Traffic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic Signals</td>
<td>Updated list of traffic signals in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Facilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Facility or Rehab of Existing Facility</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rail Project</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rails</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rail Project</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>District Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Milestone – Final Design and Construction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Project Type</strong></td>
<td><strong>Required Information/Document</strong></td>
<td><strong>Instructions</strong></td>
</tr>
<tr>
<td>Highway</td>
<td>Paving</td>
<td>Updated Routes and Mileage if necessary</td>
</tr>
<tr>
<td></td>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
</tr>
<tr>
<td></td>
<td>All other highway projects</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td>Bridge</td>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
</tr>
<tr>
<td></td>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
</tr>
<tr>
<td></td>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td></td>
<td>Retaining Wall Projects</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td></td>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
</tr>
<tr>
<td>Traffic</td>
<td>Traffic Signals</td>
<td>Updated list of traffic signals in the project if necessary</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
</tr>
<tr>
<td></td>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
</tr>
<tr>
<td>Facilities</td>
<td>New Facility or Rehab of Existing Facility</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td></td>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td>Rails</td>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
</tr>
<tr>
<td>District Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Wide Projects</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8.1 Project Location - RPM

8.1.1 Route and Mileage

The lead designer shall provide all routes and mileages for project in accordance with the following:

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

3. Select the project from the drop down or if it is a new project click “Add Project”.

4. To get the route and mileage for a project you will need to go to the ALIM system found here: ALIM System
5. Next add the route and mileages to the Project Asset Form.
8.1.2 List of Assets for the Project

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

![Figure 194 - Project Asset Form](image)

3. Select the project from the drop down or if it is a new project click “Add Project”.

![Figure 195 - Selecting Project](image)

4. On the form add all of the assets in this project.

![Figure 196 - Adding Assets](image)
8.1.3 Project Polygon Creation and Submission

The following shows how to create and submit a project polygon KML file for project location. The project polygon is created in Google Earth and attached to the Project Asset Form located on the Projectwise Project Information webpage.

1. Open Google Earth.
2. Zoom into the location of the project or use the search tool to locate the area of the project.

![Figure 197 - Searching in Google Earth](image1)

3. Next select the polygon tool to place a polygon around your project.

![Figure 198 - Polygon Tool](image2)
4. Next Type the project number in the name field and a description in the description field as shown below:

![Polygon Settings](image)

**Figure 199 - Polygon Settings**

5. Next adjust the style and color of the polygon to the settings shown below, do not click OK after you update the settings:

![Polygon Style](image)

**Figure 200 - Polygon Style**
6. Next draw the polygon for the project. This polygon should encompasses the whole project and include all the roads that this project will affect. Then click OK.

![Figure 201 - Drawing the Polygon](image)

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located in the places area, which is in the left hand side of the screen, of Google Earth. Then redraw the polygon by going back to step 3.

![Figure 202 - Deleting a Polygon](image)
7. If the project has multiple sites, go back to step 3 and create another polygon(s). After you create all your polygons they will be listed in the places area in Google Earth.

8. After all the sites are made they need to be added to the temporary places area in Google Earth so a combined KML file can be saved. To add them to the temporary places simply drag and drop all the sites into that area as shown below:
9. Next to save a KML file with all the polygons in it right click on Temporary Places and select Save Place As:

Right click on Temporary Places and select Save Place As

Figure 205 - Saving the KML File

10. Next type in the project number for the file name and select KML for the file format. Then select the folder on your computer where you want to save the file too and click Save.

Type in Project # for the name and select KML for the format

Figure 206 - Saving the KML File
11. Go to the Projectwise Project Information Webpage: Projectwise Project Information
12. Click on the Project Asset Form.

![Figure 207 - Project Asset Form](image)

13. Select the project from the drop down or if it is a new project click “Add Project”.

![Figure 208 - Selecting Project](image)
14. Next attach the KML file to the Project Asset Form by clicking on Browse and then select the file:

![Project Asset Form with instructions to click on Browse and select the file](image.png)

**Figure 209 - Attaching the KML File**
15. After you have selected the file click on attach file:

**Figure 210 - Attaching the KML File**
8.2 Project Location - Design Approval through Construction

The following shows how to create and upload a refined project polygon file at and after the Design Approval milestone of a project. The file shall be created by the lead designer in accordance with this section and uploaded into the 140_GIS folder of the applicable project in ProjectWise. For projects that were previously located using the assets or route and mileage this section does not apply. If changes are made to projects found using assets or route and mileage update that project information in accordance with Section 8.1.

8.2.1 Project Polygon

The lead designer is responsible for creating the project polygon dgn and kml files using Microstation. The following section details what needs to be included in the polygon and how to make the project polygon file for different project types.

If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or John.Rinaldi@ct.gov for guidance.

If a project has more than one site, all the polygons for that project must be included in one project polygon file. All the polygons for each intersection shall be in one file.

**Highway Projects that Touch Pavement**

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

![Project Extents](image1)

**Figure 211 – Project Extents**

The image below is an example of what a typical project polygon will look like after it is drawn in Microstation.

![Project Polygon example](image2)
**Highway Projects that DO NOT Touch Pavement**

This type of project could involve, but not limited to the following:

- Guard rail replacement
- Barrier replacement
- Noise barriers
- Retaining walls

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. If there is only a ROW line on one side of the project, draw the polygon relatively close to the edge of the work area. Below is an example of a noise barrier project and shows what to include:

![Figure 213 - Highway Project without Full Depth Reconstruction](image-url)
Full Bridge Replacement or Superstructure Replacement that Touch the Roadway

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

![Project Polygon Example](image)

Figure 214 - Bridge Polygon Example

Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway
Facilities Project
The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel the facility is located on. Any slope limits or work being done outside of this ROW line shall be included in the polygon. Below is an example of what to include:

Figure 215 - Facilities Project Example
8.2.2 Project Polygon File(s) Creation

The following steps explain how to create and submit the Project Polygon file. One polygon file shall be created for each project. If the project consists of multiple “sites,” the file shall include multiple polygons.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be referenced. This can usually be found within the ground survey file title block. If there is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. **In House CTDOT Users:** Create a new MicroStation design file using the 2D_Poly_83FT seed file located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

   Note: If your project is NAD 27 FT still use the 83FT seed.

![CTDOT CAD resource folders](image)

   **Figure 216 – CTDOT CAD resource folders**

   **Consultant Users:** Download the seed files using this link: [2D_Poly_83FT Seed File](link)

3. Reference the Highway Design file into the newly created file using true scale off and 1:1

![MicroStation reference file settings](image)

   **Figure 217 – MicroStation reference file settings**
4. Verify that the tentative coordinates of this file match the referenced design (using stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match, if they do not check that the scale of the reference is 1:1. If your project is NAD 27 FT we will move the reference file so the coordinates are correct. To move the reference file do the following:
   a. Select Reference File.
   b. Select Move Reference:

   ![Figure 218 - Move Reference](image)

   c. Next when it prompts you to “Enter point to move from”, in the Key-In Box key in XY=0,0 and click Enter.

   ![Figure 219 - Key In](image)
d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the Key-In Box key in DL=400124.9,500038.9.

Figure 220 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing, grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”)
6. Then place a closed polygon(s) using the shape tool or the smart line tool.
7. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth.
   Do this by choosing: File> Export> Google Earth.
9. Google Earth should then automatically open and zoom to the Project Polygon(s) vicinity.
8.2.3 Project Polygon File(s) Submission

The Project Polygon files shall then be uploaded into ProjectWise in accordance with the following:

1. Log into ProjectWise
2. Browse to your project’s 140_GIS folder in ProjectWise Explorer
3. Select the **Interface**, “CTDOT_Doc_Code.” If the interface box is not shown, select: View > Toolbars and select interface
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard

![Figure 221 – ProjectWise project polygon folder example](image)

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
7. When upload is complete, the Lead Designer shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

   John.Rinaldi@ct.gov (AEC),
   Mathew.calkins@ct.gov (AEC)
   Henok.Abdissa@ct.gov (AEC)

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to the label attribute.
Section 9 Rights of Way (ROW) Files

This section details the submission of the following Rights of Way (ROW) Files:

- Property Maps Files (.dgn and PDF)
- Parcel Polygon Files (.dgn and KML)

These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

9.1 Submission of the Property Maps Files

The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in accordance with the following:

1. Log into Projectwise.
2. Browse out to your project and upload the Property Map DGN and PDF into the 05_Property_Maps folder and 310_Review folder respectively as shown below:

![Image showing Property Map DGN and PDF folders]

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
7. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:
   - ROW Administration/Assistant Director – Thomas.Ohala@ct.gov
   - ROW Supervising Coordinator - Robert.Ike@ct.gov
   - ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, Shandi.Wong@ct.gov
   - Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov
   - Appropriate Project Coordinator - Steven.Degen@ct.gov, Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.Ireland@ct.gov

To submit a revision to the property maps, use the same steps above but add “Revised” to the label attribute.
9.2 Parcel Polygon File(s)

The Parcel Polygon files shall be created by the creator of the property map and represents the area to be acquired by the State. It should be accurately based on existing property lines and proposed Rights of Way lines. These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

9.2.1 Parcel Polygon File(s) Creation

The following steps explain how to create and submit the Parcel Polygon CAD file(s). One file shall be created for each parcel - only permanent land and easement acquisition areas.

When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the Property Map shall also be submitted into ProjectWise in accordance with this manual, see section 9.

![Figure 223 – Property Map parcel area example](image)

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map is in. This is usually found within the referenced ground survey file title block
2. **IN House CTDOT Staff** – Then create a new MicroStation design file using the correct seed for the datum in the project located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

![Figure 224 - Seed File](image)
Consultant Staff: Download the seed files using this link: [Geospatial Seeds]

3. Reference the Property Map file into the newly created file using true scale off and 1:1

![Figure 225 - Reference File](image)

4. Verify that the tentative coordinates of the new file match the Property Map (using stationing, grids, etc.)
5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).
6. Then place a closed polygon using the shape tool or the smart line tool.
7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the creation of property maps. The task contains “Shape for GIS” tools which can be used for polygon creation:

![Figure 226 – Custom MicroStation tasks](image)

8. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth by choosing: File> Export> Google Earth.
10. Google Earth should then automatically open and zoom to the Project Polygon vicinity.
9.2.2 Parcel Polygon File Submission

The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following. [Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted]

1. Log into ProjectWise
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project.

![Figure 227 – ProjectWise parcel polygon folders example](image)

3. Select the **Interface**, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
7. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

   - ROW Excess Property Inventory/GIS Unit (EPIU) - [John.Durling@ct.gov](mailto:John.Durling@ct.gov), [Shandi.Wong@ct.gov](mailto:Shandi.Wong@ct.gov)

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to the label attribute.
Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam
These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

1. Open Bluebeam by selecting the desktop icon:

If you do not have a desktop icon, select Start>Bluebeam Software. Right click on Bluebeam Revu, select Send To>Desktop (create shortcut). This will place the Bluebeam icon on your desktop:

Figure 228 - Creating Desktop Shortcut
2. When the “Welcome to Revu” dialog box opens, select **Design** profile and **Dark** look:

![Figure 229 - Welcome to Revu](image)

3. A dialog box may appear asking if you would like to add a ProjectWise Client Interface. Select **Yes**:

![Figure 230 - Bluebeam/Projectwise Link](image)
4. Enter ProjectWise Login Name and Password. Check “Checkout on Open” and “Checkout on Open from Hyperlinks”. Select OK:

![ProjectWise Login](image1.png)

**Figure 231 - Projectwise Login**

5. Click on the settings icon in the top right hand corner and click Preferences as shown below. If you cannot find the settings icon in the top right, go to the Edit menu and select Preferences.

![Bluebeam Preferences](image2.png)

**Figure 232 - Bluebeam Preferences**
6. Click on File Access and make sure the box is checked as shown below: If ProjectWise is not listed click on Add

![Figure 233 - Projectwise Integration](image)

After you click Log in the status should read Logged In as shown below:

![Figure 234 - Projectwise Integration](image)
7. In the General section in the User area type in your name (First Initial and Last Name), title, and your office name. An example for me would be M. Calkins TE 2 AEC Applications. An example for a district construction user would be J. Smith TE 3 D2 Construction.

![General Preferences](image1)

Figure 235 - General Preferences

8. Update the markups options to match the following:

![Markup Preferences](image2)

Figure 236 - Markup Preferences
9. Update the markups tab options to match the following:

[Image - Markup Preferences]

Figure 237 - Markup Preferences

10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web Tabs is unchecked. This will open any hyperlink that is in a PDF document using Internet Explorer instead of Bluebeam. This is the last preference you will need to update so you can click Ok at the bottom right now.

[Image - Webtab Preferences]

Figure 238 - Webtab Preferences
Downloading the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile
2. Double click on the profile in the zipped folder on your desktop.

![Figure 239 - Importing the Bluebeam Tools](image)

Bluebeam Stamps

For CTDOT Use only

To be able to select your stamps follow the figure below:

1. Select the Markup tab and select Stamps>Change Stamp Folder.

![Figure 240 - Selecting a Stamp Folder](image)

2. Browse to `\SH3DGS18\CTDOT_Projects\V8_Admin\Bluebeam Resources` and select correct discipline.
Figure 241 - Selecting Stamp Folder

Browse to folder and select discipline
Select OK
Appendix B - Usability of PDF Documents

Usability of PDF Documents
This section contains information about viewing digital contract documents.

Structure of Digital Plans

Final Design Plans, Addendums, and Design Initiated Change Orders

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example of a project’s discipline subsets in Projectwise:

<table>
<thead>
<tr>
<th>Label (case sensitive)</th>
<th>Description</th>
<th>Rate</th>
<th>Category</th>
<th>Sub Category</th>
<th>Sub Category Description</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>01_Site</td>
<td>General</td>
<td>CONI</td>
<td>FPL</td>
<td>01_Site</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>02_Bridge_A1</td>
<td>Site_A1</td>
<td>CONI</td>
<td>FPL</td>
<td>01_Site_A1</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>03_Highway</td>
<td>Final Plans (Ad)</td>
<td>CONI</td>
<td>FPL</td>
<td>03_Highway</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>05_Traffic</td>
<td>Final Plans (Ad)</td>
<td>CONI</td>
<td>FPL</td>
<td>05_Traffic</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>05_Landscape</td>
<td>Final Plans (Ad)</td>
<td>CONI</td>
<td>FPL</td>
<td>05_Landscape</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>05_Structures</td>
<td>Final Plans (Ad)</td>
<td>CONI</td>
<td>FPL</td>
<td>05_Structures</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
<tr>
<td>05_TRAFFIC_STD</td>
<td>Final Plans (Ad)</td>
<td>CONI</td>
<td>STD</td>
<td>05_TRAFFIC_STD</td>
<td>Final Plans (Ad)</td>
<td>Acrobat PDF</td>
</tr>
</tbody>
</table>

Figure 242 - Discipline Subsets in Projectwise

As-Built’s
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

The PDF digital plans have the following functions when the digital contract plans are created in accordance with this manual:
- Turn levels on and off
- Search for all text on the documents.
- PDF plans are measurable
Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier viewing of the contract sheets. See below for turning levels on and off:

![Digital Plan Levels](image)

Figure 243 - Turning Levels On and Off
Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a certain pay item.

See below for searching the PDF Plans for text.
Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not need to be created for on desk measuring.

See below for measuring in PDF.

Figure 245 - Measuring Tool
Digital Specification Package

The FDP specification package will be one PDF document and located in the 110_Contract_Specifications folder. This package includes all specifications, Notice to Contractors, Wage information, etc.

The Addendum specifications prepared in the same way as the FDP specification package and will also be located in the 110_Contract_Specifications folder.

The Design Initiated Change Order specifications will be contained in one PDF document located in the 110_Contract_Specifications folder when they are released to the Contractor.

Some useful features on the digital specification package are:
- Search for any text in the document, see Searching Digital Plans
- Bookmarks for each section in the specification package
**Document Compare Tools**

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay Pages. Compare Documents will compare two documents and create a third document that clouds all the changes. Overlay pages will create a third document where the pages of document A will become one color and the pages of document B will become another color. When the pages are overlaid you will be able to see the changes from the difference in these two colors. Both of these tools can be used for single and multipage PDF documents. The following shows how to perform a document compare and how to use the overlay page tool.

**Document Compare**

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

![Image](image1.png)

**Figure 247 - Compare Documents**

3. In the window that pops up you will notice the two documents that were just opened. Click OK to run the document compare as shown below:

![Image](image2.png)

**Figure 248 - document Compare**
Overlay Pages

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

3. In the window that pops up you will need to select which pages of each document you want to overlay. To do this double click on a file, then in the window that pops up type the pages you want to overlay. The example below shows pages 1-28. Once you select the pages you want to overlay click OK.
Appendix C - Using the Set File

Opening the Set File

Double click on the set file from Projectwise and open as shown below: This may take a while please be patient. Note: The first time opening a set file will take longer than any subsequent times.

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a thumbnail view. To view a sheet, simply click on that sheet and it will open up.

Figure 252 - Opening a Set File

Figure 253 - Viewing a Plan Sheet from a Set File
Marking Up a Set File

1. Open up the set file by following Section 1.4.1. You will notice on the left hand side of the screen will be thumbnails of all the sheets in the set file.

Figure 254 - Sheets in the Set File
2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it. You will notice that sheet opens up on the right.

Figure 255 - Marking Up a Sheet
3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this, right click on the lock and select Check Out.

![Figure 256 - Checking Out a Document](image1)

4. Notice the lock changes to a Check and you will be able to markup the document.

![Figure 257 - Checking Out a Document for Editing](image2)
5. To mark up the plans use the tools located in the tool chest shown below:

![Image showing tool chest and plan sheets]

**Figure 258 - Marking up the Plan Sheets**
6. When finished, click Save and then right click on the Check and select “Check In”.

![Image of saving markups and checking into Projectwise]

Figure 259 - Saving Markups and Checking Into Projectwise
Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows how to search a set file:

1. Click on the Search Set file icon and then type in what you want to search for as shown below:

![Figure 260 - Searching the Set File](image)

**Click on the search set file icon**

**Type in what you want to search for**

**Select "Current Set"**

Figure 260 - Searching the Set File
Creating a Consolidated PDF of the Files in the Set File

Bluebeam allows you to create a consolidated pdf of all the files in a set file. The following shows how to create a consolidated pdf:

1. Select the Publish Icon and select Combine:

   ![Figure 261 - Consolidating Files](image1)

2. Next keep the default settings and click OK on the dialog box shown below:

   ![Figure 262 - Consolidating Files](image2)
3. Bluebeam will then create a consolidated file of all the PDF in the set file.

![Consolidated PDF of all the files in the Set File](image)

Figure 263 - Consolidated File
Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions. Printing the entire set will print all the sheets in the set file. Printing the latest revisions will print the most up to date sheets and not print the previous revisions. Printing the previous revisions will only print the sheets that were changed by a revision.

The following shows how print a set file:

1. Select the print set file icon and select the desired option:

   ![Select the arrow on the print icon and select the desired option](image)

Figure 264 - Printing a Set File
Appendix D – Consultant Submittal Review Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This profile imports all the commenting tools in the correct format. Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file located in the zip file and the profile will be imported. After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

   ![Image of tool chest with delete stamp highlighted]

   **Figure 265 - Deleting the Stamp**

2. Next Consultant Designers will need to save the following stamp to their computer and edit it to add their company name and address. The following will show how to do that:

3. Save this stamp file to your computer in a folder somewhere called Bluebeam Stamps. Note: The stamp file will be a PDF. Consultant Submittal Review Stamp

4. Open the stamp file using Bluebeam.
5. Update the Company Name and Address as shown below:

![Figure 266 - Updating Stamp for Company Name and Address](image)

After the company name and address is updated it should look like this:

![Figure 267 - Updated Stamp](image)

6. After the stamp is updated click save.
7. Next go to Markup>Stamp> and Select Change Stamp Folder.

8. Browse out to where the submittal review stamp has been saved and click OK:

9. Now when you click on Markup>Stamp it will be in the list.
10. Next go into the tool chest and open the “Recent tools” as shown below:

![Figure 270 - Bluebeam Recent Tools](image)

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown below:

![Figure 271 - Placing a Stamp in Bluebeam](image)
12. Select Conforms when the javascript window pops up and click OK:

![Figure 272 - Bluebeam Stamp](image)

13. After the stamp has been placed you will see the stamp in the recent tools. Drag it from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

![Figure 273 - Adding the Custom Stamp to the Tool Chest](image)

14. Then Save Profile so the stamp will always be in the Tool Chest.
Figure 274 - Saving Bluebeam Profile

Go to View, then click on the arrow and then save profile.
## Appendix E – Projectwise Attributes Table

### Table 3 - Projectwise Attribute Assignments – Contract Plans and Specs.

<table>
<thead>
<tr>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Attributes</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contract Plans</strong> – Upload to the 100_Contract_Plans Folder</td>
<td>CT</td>
<td>CON</td>
<td>FDP</td>
<td>Name of the subset, 01-General for the General subset. The label should match what is listed on the title sheet.</td>
<td>Type in a useful description</td>
<td>Asset Tags shall only be assigned to the contract plan subset(s) that detail an asset in a high level detail. For example, the subset that contains bridge plans shall be tagged with that asset. If there are multiple bridges detailed in a subset, the subset shall be tagged with both bridge nos.</td>
<td></td>
</tr>
<tr>
<td>Contract Plans</td>
<td>CT</td>
<td>CON</td>
<td>FDP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>DCD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>FPL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>ADP</td>
<td></td>
<td>ADP and ACD submittals shall have the same label as the FDP plans with the addition of A# on the end. For example, 01-General_A#</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>ACD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>DCO</td>
<td></td>
<td>DCO Submittals shall have the same label as the FDP plans with the addition of C# on the end. For example, 01-General_C#</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Contract Specifications</strong> – Upload to the 240_Contract_Development Folder except for CSP specs, upload these to the 110_Contract_Specifications folder</td>
<td>CT</td>
<td>CON</td>
<td>FSP</td>
<td>Revised FDP Specs.</td>
<td>Type in a useful description</td>
<td>Do not assign asset tags to specifications</td>
<td></td>
</tr>
<tr>
<td>Contract Specifications</td>
<td>CT</td>
<td>CON</td>
<td>FSP</td>
<td>Revised FDP Specs.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>FSR</td>
<td>Addendum # Specs.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>ASR</td>
<td>Revised Addendum Specs.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
<td>CSP</td>
<td>C# Specs.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Table 4 - Projectwise Attribute Assignments - Supplemental Contract Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplemental Contract Documents</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Upload to the 240_Contract_Development Folder</td>
<td></td>
</tr>
<tr>
<td>Proposal Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Proposal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proposal Estimate Checklist</td>
<td>CT</td>
<td>MISC</td>
<td>Misc</td>
<td></td>
<td>Proposal Est. Checklist</td>
<td></td>
</tr>
<tr>
<td>Federal Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Federal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calendar Day Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Calendar Day</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final Design Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>Final Design</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categorical Exclusion</td>
<td>CT</td>
<td>MISC</td>
<td>Misc</td>
<td>Categorical Exclusion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Approval Letter</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Approvals</td>
<td>Design Approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Environmental Permits</td>
<td>CT</td>
<td>PERMITS</td>
<td>Permits</td>
<td></td>
<td>Inland Wetland, SHPO, Flood Management, Environment Review, Natural-Water Resources, Tribal, Endangered Species, Fisheries</td>
<td></td>
</tr>
<tr>
<td>DBE/SBE Approval with percentages</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Approvals</td>
<td>DBE/SBE Approval</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Commitment List</td>
<td>CT</td>
<td>MISC</td>
<td>Misc</td>
<td>Commitment List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agreements</td>
<td>CT</td>
<td>AGREEMENT</td>
<td>Agreements</td>
<td>Name of the Agreement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proprietary Item Approval</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Approvals</td>
<td>Proprietary Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standalone Transportation Management Plan Document, taken from the final design report</td>
<td>CT</td>
<td>MISC</td>
<td>Misc</td>
<td>Trans. Man. Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item List for Contractor Submittals</td>
<td>CT</td>
<td>MISC</td>
<td>Misc</td>
<td>CNS Item List</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 5 - Projectwise Attribute Assignments – Engineering Reports, GIS Documents, and ROW Documents

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Document Date</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Engineering Reports</strong> – Upload to 130_Engineering_Reports Folder</td>
<td>Hydraulic Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>Hydraulic</td>
<td>Hydraulic Report Data</td>
<td>Date of Report</td>
<td>Type in Featured Crossed</td>
</tr>
<tr>
<td></td>
<td>Scour Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>Scour</td>
<td>Scour Report Data</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Floodway Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>Floodway</td>
<td>Floodway Report Data</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Geotechnical Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>Geotechnical</td>
<td>Geotechnical Report</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>GIS Documents</strong> – Upload to the 140_GIS folder</td>
<td>Project Polygon File (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Boundary</td>
<td>Project Polygon File (.KMZ)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>ROW Parcel Microstation File (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td>N/A</td>
<td>A useful description such as property owner’s name (e.g. CL&amp;P)</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>ROW Parcel Microstation File (.KMZ)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td>N/A</td>
<td>A useful description such as property owner’s name (e.g. CL&amp;P)</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>ROW Documents</strong> – Property Map (.dgn) to 500_Pre-Design&gt;05_Property_Maps Folder, Property Map (.pdf) to the 310_Review_Documents folder</td>
<td>Property Map (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>MAP</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td>N/A</td>
<td>A useful description such as property owner’s name (e.g. CL&amp;P)</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Property Map (.pdf)</td>
<td>CT</td>
<td>CAD</td>
<td>MAP</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td>N/A</td>
<td>A useful description such as property owner’s name (e.g. CL&amp;P)</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Table 6 - Projectwise Attribute Assignments – Contractor Submittals

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Document Date</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contractor Submittals</strong> – 120_Contractor_Submittals</td>
<td>Working Drawings for Permanent Structures</td>
<td>CT</td>
<td>CONTRACTOR</td>
<td>Working Drawings</td>
<td>Item Number</td>
<td>Working Drawings for Permanent Structures</td>
<td>Date of Submittal</td>
<td>Type a useful description</td>
</tr>
<tr>
<td></td>
<td>Working Drawings for Temporary Structures</td>
<td>CT</td>
<td>CONTRACTOR</td>
<td>Working Drawings</td>
<td>Item Number</td>
<td>Working Drawings for Temporary Structures</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Shop Drawings</td>
<td>CT</td>
<td>CONTRACTOR</td>
<td>Shop Drawings</td>
<td>Item Number</td>
<td>Shop Drawings</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>RFI</td>
<td>CT</td>
<td>CONTRACTOR</td>
<td>RFI</td>
<td>RFI #</td>
<td>RFI</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>RFC</td>
<td>CT</td>
<td>CONTRACTOR</td>
<td>RFC</td>
<td>RFC #</td>
<td>RFC</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>